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1. Introduction

Welcome to the Sun workstation network in the College of Engineering at Bucknell University.

There are three SUN laboratories in the Dana Engineering Building: rooms 231, 314 and 350.

Dana 231 and 350 are college laboratories and they are open for public use when no classes have

been reserved. Dana 314 is a limited access lab for use by Computer Science faculty and

students. The Dana 231 lab has 24 Ultra 10 workstations, the Dana 314 CS SUN lab has 9 Ultra

1 workstations; and Dana 350 has 24 Ultra 10 workstations, all manufactured by SUN

Microsystems, Inc.  This manual serves as an introduction to the facilities available on the SUNs

including the introduction to the CDE window environment, called Common Desktop

Environment1 and the UNIX2 operating  system.

In the following sections you will learn how to access the SUN workstations and how to use

them in creating, compiling, and running most common languages programs (e.g. FORTRAN,

C/C++, HTML).  You will also learn about the basic UNIX command and the facilities for

printing files and sending and receiving electronic mail.  This manual was written with the first

time user in mind.  It is written in a straight forward manner so you can understand the material

and can quickly become comfortable using the SUN workstations.  The best way to learn much

of what is in this manual is to take the manual with you and work through the examples sitting at

a workstation.

Always take the manual to lab when you are working on the SUNs.

1.1 What is a SUN workstation?

SUN workstation is a powerful computer developed by SUN Microsystems.  The workstation

consists of a large video screen for sophisticated graphics, a keyboard and a mouse.  All the

workstations are connected together forming a computer network.  Since the machines on the

network are relatively close together the network is referred to as a Local Area Network (LAN).

There are other campus computer facilities on this LAN including a DEC 5500 computer (called

coral) and many Apple Macintoshes and  IBM PC's.  A new operating system Solaris™ 8 was

installed in summer 2000 as the platform for the SUN workstation.

                                                
1 CDE is a registered trademark of SUN Microsystems, Inc.
2 UNIX is a registered trademark of AT&T
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Some of the machines have internal CD-ROM or disk drives attached to them, as you may be

used to seeing on personal computers.  All student and system files are maintained on these

disks.  The workstation you use accesses files by requesting them from a network server, a

separate computer whose task is to supply requested files to workstations on the network.

There are seven servers:  castor, pollux, spectrum, zeus, hera, cerebus and hydra.  Cerebus and

Hydra are the file servers;  the others are compute servers and are mostly for remote access.

Cerebus and Hydra contain a special feature, Snapshots, which allows users to restore their own

files without system administrator intervention.  See Backing up your files by using Snapshots in

Section 8.3.  Since your files are not located on any particular workstation, you may  access them

from any workstation in any lab.  So, when you come to the lab you don't have to bring floppy

disks and you do not have to use  the same workstation every time.

1.2 The Mouse

The three-button mouse that is attached to the keyboard is a pointing device used by many

workstation programs.  The Sun mouse is a mechanical mouse that is similar to most mice found

attached to PC’s.

1.3 The Keyboard

The SUN workstation's keyboard has the basic configuration as a typewriter or personal

computer keyboard for the letters, numbers, and special characters.  However, the workstation's

keyboard has additional keys that allow special actions to occur.  Here are some of the more

commonly used special keys:

Return This key signals to the computer that you have finished typing and you want it to

perform what you typed.  Whenever you are waiting for the SUN to do something,

make sure you have pressed the Return key.

Delete This key causes the last character typed to be erased.

Control This key acts similarly to the shift key on a typewriter; when the key is held down

and another key is pressed, some special action occurs.  For example, you can stop

a execution by pressing Control c.

Caps Lock This key is similar to a caps lock on a typewriter.  If you press the Caps Lock key,

a light in the upper right corner of the keyboard appears green.  If you want to

switch to lower case letters, just press the Caps Lock key again.

Esc This key is pressed just like a letter or number.  It is not held down like the Shift

or the Control  keys.
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♦  (meta) There are two meta keys marked with a diamond ♦  located to the left and right of

the space bar.  They are used in some applications (like the Emacs editor) in a

similar way to the control key

1.4 Operation Hours

The SUN labs are normally open 24 hours a day, 7 days a week.  The labs are closed to the public

either there is a class scheduled or during rare maintenance periods which are announced in

advanced.  It is advised to check the printed weekly schedule before walking into the lab.

1.5 Seeking Assistance

UNIX is very sophisticated and you may find times when you need some assistance in solving a

problem related to how the system works (or doesn't work!).  A good source of help is other

students in the SUN labs.  It is often the case that there is a more experienced person in the lab

who can solve your problem, or there may be someone who is not experienced but has

experienced your problem and knows how to resolve it.  System support is available through

email: ecst@bucknell.edu, call at x71460 or x73714, or you can stop by the office in Dana room

230.  Your instructor is always willing to explain different facets of the system.  The best time for

help is during your scheduled lab period.  When you work by yourself, jot down the things that

were confusing and ask your lab instructor during the next lab period.

1.6 References on UNIX

This manual does not contain a complete description of the facilities of the UNIX operating

system.  If you take two or more computer science courses you may want to buy a text on the

UNIX operating system.  There are many reasonable texts, for example:

a) A Students Guide to Unix by Harley Hahn, McGraw Hill, 1993.

b) Unix Shell Programming by Stephen Kochan and Patrick Wood, Hayden, 1990.

c) Unix in a Nutshell by Daniel Gilly and O'Reilly staff, O'Reilly, 1992.

2. Getting Started - The Common Desktop Environment

The SUN workstations run the UNIX operating system, which provides an interface through

which the user can access files and various system services.  Constructed on top of the UNIX

operating system is a windowing system called Common Desktop Environment (CDE).  This
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windowing system provides a more convenient working environment than the plain UNIX

interface.  Your account is set up to automatically use CDE.  In order to gain access to the power

of the SUN workstations and to the account which has been set up for you, you have to “log in”.

2.1 Before Logging In

When you enter the lab and sit down at one of the workstations you will either find the screen on

(i.e., with a picture or words displayed) or all dark (strangely referred to as blank!).  Each

workstation is set up with a “screen saver”, which blanks the screen if no key is pressed or the

mouse moved for some relatively short period of time (ten minutes).  If the screen is blank then

press the delete key to regain control from the screen saver.  At this point you should see the

login window.

Before proceeding be sure that the Caps Lock key is not on.  There is a green light somewhere on

the keyboard (usually on the Caps Lock key or at the top of the keyboard) which indicates

whether the Caps Lock is on or off.

Though the above scenario is the usual, it is possible that you will sit down at a machine with the

power switch off.  In this case locate the power switch on the back, right side the tower.  You

will see a ‘0’ and a ‘1’ on the switch.  Press the switch toward the ‘1’.  The front power switch

might also be off. If the green light isn’t on above the push-in switch, push it in. The workstation

will go through a lengthy startup procedure (perhaps for a minute).  When it has completed this

process a login window will appear on the screen.
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2.2 Choosing the Environment to Login

In addition to CDE, the Sun workstations offer other ways of working with the UNIX operating

system:  OpenWindows, X-Windows, and the UNIX command line.  The default environment is

CDE.

2.2.1 Logging In

The Computer Center sent you an username and password used for logging in to the computer

network.  Your username will usually be your last name or something close to your last name.

Remember to type your username in all small letters.  Once you have typed your username, press

the Return key or the OK button.

At this point, you will be asked to enter your password.  Your password must be entered exactly

as it appears on the sheet from the Computer Center, followed by pressing the Return key or

the OK button.  You will notice that as you type your password no letters appear on the screen.

This is a security measure so that someone cannot learn your password by looking at your screen

as you log in.

If you have made a mistake in entering your account name or your password, you may click on

the Start Over button, otherwise the system will put up the login incorrect window and ask

you to try again.

2.2.2 To run OpenWindows

•  Click the Option button and choose Session

•  Select OpenWindows Desktop

•  Login
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2.2.3 To run the last Desktop Windows

•  Click the Option button and choose Session

•  Select User's Last Desktop

•  Login

2.2.4 To use the UNIX command line

•  Click Option

•  Select Command Line Login

•  Press Return to get the login prompt

•  Login

•  At the prompt “Enter w for OpenWindows; x for X-Windows; RET to exit:” press Return

2.2.5 To run X Windows

•  Follow the first four steps of UNIX command line login

•  At the prompt “Enter w for OpenWindows; x for X-Windows; RET to exit:”  type x then

Return

2.3 Workspaces and the Front Panel

CDE allows you to use four workspaces, which act as if you are using different desktops.  The

Front Panel is a special desktop window that contains a set of controls for doing common tasks.

The Front Panel moves with you as you switch workspaces.

2.3.1 The Front Panel

The Front Panel is the horizontal window at the bottom of the display.  It contains a number of

controls you use often, including the workspace switch, which contains buttons for changing to

other workspaces.
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Many of the buttons in the Front Panel start applications when you click them - for example, the

File Manager and the Desktop Controls buttons.

Some controls are drop zones - for example, the Printer and Trash Can controls.  You can drag a

file from File Manager or Application Manager to the control.

Certain controls, such as the clock and activity indicator, are indicators that tell you something

about the state of your system.  Other controls have a dual purpose; for example, the Calendar

and Mailer controls are both indicators (showing today's date and the arrival of new mail,

respectively) and are buttons for starting applications.

The following are the default controls available on the Main Panel, from left to right.  These

terms are used to describe controls:

Click:  What happens when you click the control.

Drop:  What happens when you drop a file or folder icon on the control.

Indicator:  What the image of the control represents.
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Clock (Links)

Click: Opens the default browser. Indicator: Displays the current time.

Calendar (Cards)
Click: Starts the Calendar application Drop: Dropping an appointment
file adds the appointment to the calendar. Indicator: Displays the current
date.

File Manager (Files)

A desktop application where you can create, find, and use workspace

objects: files, folders, and applications.  The File Manager gives you an

icon interface similar to a Macintosh or Windows 95 desktop.  Click:

Opens a File Manager view of your home folder.  Drop: Opens a File

Manager view of the dropped folder.

Text Note (Applications)

This control position is reserved for a personal application of your choice.

You can put an application here by first installing the application icon

into the Personal Application subpanel, and then using the control's pop-

up menu to place that control in the main panel.  The default application

icon on the Main Panel is the Text Editor.  Click: Starts the application

(Default: Text Editor).  Drop: Opens the dropped file in a new Text

Editor window.

Mailer (Mail)

A tool for sending, receiving, and managing electronic mail (e-mail)

messages.  Click: Starts the Mailer.  Drop: Attaches dropped item to a

New Message window.  Indicator: Indicates arrival of new mail.

Lock

Click: Locks the display and keyboard.  You must type your password to

unlock the system.

Workspace switch

Click: Changes between workspaces.  Indicator: Shows current

workspace.

Activity Indicator

Click: Displays a Go action dialog box. Drop: Runs action (for example,

a browser) registered for data type dropped. Indicator: Spins when the

system is running an action.
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Exit

Click: Logs you out of the current session.

Default Printer  (Personal Printers)

Click: Displays the status of the default printer, lets you cancel print jobs

on that printer.  Drop: Prints the file on the default printer.

Style Manager (Tools)

Click: Starts the Style Manager application. If the application is already

running, its window is raised to the top of the window stack.

Performance Meter (Hosts)

Click: Opens Performance Meter. Drop: Opens Performance Meter for

the hostname dropped. Indicator: Once activated, indicates CPU and

disk activity.

Help Manager (Help)

Click: Opens a Help Viewer window displaying the top level of help

information.

Trash Can

Click: Opens the Trash Can window.  Drop: Moves the file or folder to

the Trash Can.  Indicator: Different appearance when empty and non-

empty.

2.3.2 The Subpanels

If a control in the Main Panel has an arrow button on top of it, then that control has a subpanel.

Clicking on the up arrow button on the Main Panel pops up the subpanel.  Clicking on the down

arrow beneath a displayed subpanel closes it.  Subpanels always contain an Install Icon control

that is used to customize the subpanel.  One of the controls of the subpanel is also displayed on

the Main Panel.  Controls in subpanels also have Click, Drop, and Indicator properties like

controls on the Main Panel.  The default subpanels of the Main Panel are:

•  Links

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Web Browser – Click: Opens default browser. Drop: Opens default browser for URL

dropped.

♦  Personal Bookmarks – Click: Opens File Manager view of personal bookmarks. Drop:

Opens default browser for URL dropped.

Find Webpage – Click: Opens default browser for the Sun Microsystems search site.
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•  Cards

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Calendar – Click: Opens Calendar for the current date and user. Drop: Sets up the

dropped appointment.

♦  Find Card – Click: Opens Address Manager with default search options. Drop: Opens a

dropped card, or opens Address Manager with default options and searches for dropped

text.

•  Files

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Home Folder – Click: Opens File Manager view of your home directory ($HOME).

Drop: Opens File Manager view of dropped folder.

♦  Open Floppy – Click: Loads a diskette in drive and displays File Manager view of it.

♦  Open CD-ROM  - Click: Loads a CD-ROM volume in drive and displays a File Manager

view of it.

♦  Properties… – Click: Opens Properties dialog box with no file selected. Drop: Opens

Properties dialog box for file or folder dropped.

♦  Encryption… – Click: Prompts for the file to be encrypted and the encryption key. Drop:

Encrypts and replaces an unencrypted file; decrypts and replaces an encrypted file.

♦  Compress File – Click: Prompts for file to be compressed. Drop: Compresses and

replaces an uncompressed file; decompresses and replaces a compressed file.

♦  Archive – Click: Prompts for file or folder to be archived. Drop: Archives and replaces

dropped file or folder.

♦  Find File – Click: Opens File Finder in default mode. Drop: Searches for dropped text as

file or folder name.

•  Applications

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Text Note – Click: Opens Text Editor in note mode. Drop: Puts the dropped file on the

workspace.

♦  Text Editor – Click: Opens Text Editor. Drop: Opens the dropped file in Text Editor.

♦  Voice Note – Click: Opens Audio in note mode.

♦  Applications – Click: Opens Application Manager.
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•  Mail

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Mail – Click: Opens Mailer. Drop: Displays New Message dialog box and attaches

dropped file.

♦  Suggestion Box – Click: Opens New Message dialog box to send to the default

suggestion box mail alias for Solaris at Sun Microsystems. Drop: Displays New Message

dialog box for suggestion box mail alias and appends dropped file.

•  Personal Printers

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Default – Click: Open Printer Jobs for your default printer. Drop: Prints the dropped file

on the default printer.

♦  Print Manager – Click: Opens Print Manager for all printers available on your network.

Drop: Prints the dropped file on the selected printer. This is a useful method of printing to

a printer other than your default printer.

•  Tools

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Desktop Controls – Click: Opens Style manager.

♦  CDE Error Log – Click: Displays the error file ($HOME/.dt/errorlog) which contains

CDE errors after session startup.

♦  Customize Workspace Menu – Click: Warns you to update the workspace and opens a

File Manager view of the Workspace menu.

♦  Add Item To Menu – Click: Opens the Add Item to Workspace Menu dialog box.

♦  Find Process – Click: Opens Process Manager for your workstation. Drop: Opens

Process Manager in default mode.

♦  Hotkey Editor – Click: Edits hotkeys set up for your session.

•  Hosts

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Performance – Click: Opens Performance Meter for your workstation. Drop: Opens

Performance Meter in default mode.

♦  This Host – Click: Opens Terminal window for your workstation.

♦  System Info – Click: Opens Workstation Information for your workstation. Drop:

Displays Workstation Information for dropped host name.
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♦  Console – Click: Opens Console for your workstation.

♦  Find Host – Click: Opens Address Manager to search for host cards. Drop: Searches for

dropped host name.

•  Help

♦  Install Icon – Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Help Manager – Click: Opens a Help Viewer window displaying the top level of help

information. Drop: Dropping a master volume file (*.sdl) opens that help volume.

♦  SunSolve Online – Click: Opens a browser for the Sun Microsystems documentation and

FAQ web site.

♦  Solaris Support – Click: Opens a browser for the Sun Microsystems download site for

patches, and technical support.

♦  Information – Click: Opens the Information folder in Application Manager.

♦  Desktop Introduction – Click: Displays the Introducing the Desktop help volume.

♦  Front Panel Help – Click: Displays the Front Panel help volume.

♦  On Item Help – Click: Provides on-item help for the Front Panel. Click this control, then

click the control on which you want help.

♦  AnswerBook2 – Click: Displays the AnswerBook2 viewer if you have AnswerBook2

installed.

•  Trash

♦  Install Icon - Drop:  Installs an icon dragged from File Manager or Application Manager

into the subpanel.

♦  Trash – Click: Opens Trash Can window. Drop: Moves dropped files to the Trash Can

window.

♦  Empty Trash Can – Click: Shreds (removes) contents of Trash Can window. Drop:

Moves dropped files to Trash Can window.

2.4 Mousing Around - Window Operations

After the Front Panel is on the screen, you can play with the mouse and try out some of the

features of CDE.  With the mouse pointer symbol (referred to in the manual as ‘pointer’) in the

background, and if you press the right mouse button, you should see a “menu”.  You select a

menu item by moving the pointer (with the right mouse button still depressed) onto the menu

item you want.  If you move the pointer up and down the menu, you will see each item in turn

highlighted.  If a menu item has a symbol ! at the end, it means there is another menu to be

found by sliding the pointer onto the ! (keeping the right button depressed, of course).  A menu
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item ending in the ! symbol is said to have a pull-right menu.  Ultimately, a menu item is

selected by releasing the right mouse button while the desired item is highlighted.  The rest of

this section describes a few of the facilities accessible through this main menu and how to

manipulate (move and resize) windows.

2.4.1 Which window is active?

As you have seen, the mouse allows you to move the pointer around on the screen.  The keyboard

is the third basic piece of hardware comprising the workstation.  The obvious question is, “If I

type on the keyboard, where do the corresponding characters appear?''.  The answer is simple.

The window that has the purple border is the active window.  Clicking on a window makes that

window active.  If you hold down the Alt key and press the Tab key, you can switch to different

window, including the Front Panel.

2.4.2 Main window menu

If the right mouse button is pressed while the pointer is on the boundary of the window, the

window's main menu will pop up.  This menu has six options for manipulating the window

including “Minimizing,” “Close, ” and “Refresh.”  Refresh will refresh, or redraw, the window,

Close will kill the window, and Minimizing will iconify the window.

2.4.3 Menubars

Every window has a menubar at the top with three buttons:  Pop-up, Iconify and Enlarge.  If you

click on the button on the left side of the menubar, the Main Window Menu pops downs.  Double

clicking on the square closes the window.

The button on the right with the dot in it is the iconify button.  Clicking on it will collapse the

window to a small icon in the upper left corner of the workspace.  Iconifying more than one

window tiles the icons down the left side of the workspace.

The button on the far right of the menubar will resize the window to fill the entire workspace.

Clicking on it again returns the window to its original size.
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2.4.4 Resizing windows

It is often the case that a window is too large or too small for its current purpose.  CDE provides

a simple mechanism for changing the size of windows.  Each corner of the window is specially

marked off. If you place the pointer into any one of these corners the pointer will turn into an

arrow inside a right angle.  When the pointer changes, the window can be resized.  When the

pointer changes, press the left mouse button and drag the corner to the location you want.  Notice

how an outline of the new window boundaries appears and the size (in pixels) of the window is

displayed.  When resized as you like, release the mouse button.  Resizing works the same from

any corner, but there are times you want one corner to remain anchored, so choose the opposite

or an adjacent corner as appropriate.

2.4.5 Moving and raising windows

The boundary of a window includes the outer line of the window (excluding the corner regions)

as well as the upper bar of the window (which includes the iconify button).  This boundary can

be used to raise and move the window. If a window becomes partially obstructed by other

windows, it can be ‘raised’ by placing the pointer on the boundary of the window and clicking

the left mouse button. If, instead of clicking the left button as described, you hold the left button

down and drag the mouse, you will move the entire window.  This same technique also works for

moving icons.

2.4.6 Miscellaneous

When you are working on a workstation, you occasionally find that the screen has become

“messed up”;  for example, a system message being printed on the background, rather than in the

console window.  You can often get rid of the “mess” by refreshing your screen.  You can do this

by choosing “Refresh” on the Workspace Menu.  If you select the “Refresh” option you

will notice that all your windows are redrawn - if you are using a lot of windows the process can

take several seconds, but be patient.

2.5 Logging Out

Logging out is just as important as logging in.  The logout procedure allows you to exit the

system.  If you forget to log out someone could sit down at the workstation you were using and

access (modify or even delete) your files.  To log off you simply click the Exit button on the

Front Panel.  A logout confirmation window will appear asking you to confirm that you want to
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exit; click on the OK button to confirm.  Or simply use the right most mouse button to open the

Workspace Menu and select Log out....  Be patient, this sometimes takes a minute.  Do not turn

the workstation off!!

2.6 Other Tools

Before leaving this section on the CDE environment there are a few other useful tools which you

should know about.

2.6.1 Workspace Menu

The Workspace Menu provides you with a pull-down type selection menu, where you can

execute your frequently used applications in a jiffy.  Activate the Workspace window by right

clicking your mouse button then select the applications.  You can add an item to the list of

applications in the Workspace Menu.  To begin, select the Tools submenu in the front panel.

Choose Add Item To Menu… and enter the full path and name of the application (e.g.

/usr/local/bin/emacs). Hit the Add button and the item is added to the top of your menu. You

may want to move the item, so select Customize Workspace Menu from the Tools

submenu. You can move the items in your menu around like files in the File manager. Lastly,

select Update Workspace Menu from the File menu of the File Manager view of the

Workspace Menu to update from your new menu.

2.6.2 Command Tool

The Command Tool is the OpenWindows interface to the UNIX operating system. It has no

control panel (such as you find with Text Editor) but does have a menu accessible when the

pointer is in the window proper.  The UNIX commands which you can utilize from the

Command Tool are detailed in Section 4.12.  But there are several features which make this tool

a convenient environment for interacting with UNIX.

There are two primary features which will be highlighted here: command entry and the built-in

editor.  The primary purpose of the Command Tool is to enter UNIX commands.  To facilitate

this the window always displays a UNIX prompt as the last line in the text window.  When you

type characters, they will appear on that line.  Note that the insertion point is always at some

point on the command line.  When you press the Return key whatever is entered on the line is

passed to UNIX for processing.  The details of what commands are legal and what happens if
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errors are encountered appear in Section 4.  However, there are a couple of mechanisms for

making command entry easier.  First, the command line can be edited using the mouse to move

the insertion point in the line or to select a portion of the line.  This type of command line editing

is not available in most UNIX environments.  Also, a character sequence appearing anywhere in

the text pane can be copied to the clipboard and then pasted to the command line (at the current

insertion point).

As a convenience, the Command Tool has an option to split the screen in half, with the upper

half the UNIX interface, and the lower half a Text Editor window.  The editor window can be

created by selecting the Enable option from the File Editor pull right menu on the main menu

of the Command Tool (pointer in the text pane).  Once enabled the editor can be removed by

selecting the Disable option from the same menu option.  It is possible to copy text from the

UNIX interface window (using the Copy key) and then pasting the copied text to the editor half

of the window.  This is convenient for producing and storing in a file a record of the execution of

a program.  You may find other times when this option is convenient.  When enabled the editor

subwindow has exactly the same functionality as described for Text Editor in Section 3.

2.6.3 Terminal Emulator (Dtterm)

Terminal is a CDE Desktop application that displays a default terminal emulator window.  And

terminal emulator is a window that emulates a particular terminal type for running non-window

programs.  The most common use of terminal emulator windows is interacting with your

computer's operating system by typing commands.

There are several ways you can start a CDE Desktop terminal emulator:

•  From the Front Panel

The This Host item is located in the Hosts submenu.  After you click it, the activity

indicator spins, indicating that the terminal is being activated.

•  From File Manager

Choose Open Terminal from the File menu

•  From a command in an existing terminal window

Type dtterm at the prompt.

•  From Application Manager

The Terminal icon is located under Application Manager - Desktop_Apps.

•  From New in the Terminal Window pulldown menu
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Choose New from the Window menu in an existing Terminal window.  A duplicate Terminal

window appears.

2.6.4 Text Editor

The Text Editor is a mouse-based editor application. There are two versions available on the

SUNs.  The default , dtpad, comes with the CDE window environment.  The other,

textedit, comes with the OpenWindow environment.  The two versions are similar in their

features and behaviors, and can be used to create and modify text files including program code,

term paper, and lab report.

Dtpad will be described in detail in Section 3.  A tutorial is available to help you get started

with basic editing using the textedit.  It is located in the directory

/home/hydra/COURSES/cs203/Tutorials under the name Textedit  You may load it into a

textedit window and follow its instruction to learn the editor.

2.6.5 Performance Meter (OWperfmeter)

The strange looking strip meter, which appears on the Workspace submenu and front panel, is a

performance meter.  The meter is updated every two seconds (this can be modified) to reflect

how busy your workstation's CPU is.  The longer you work with the workstations the more useful

you will find this meter.  Note that, if a hostname is not specified after the perfmeter command,

the current machine's CPU usage is displayed by default.

To obtain more information about Performance Meter, consult the man pages by typing man

perfmeter at the prompt.

2.6.6 Print Manager (DtPrintManager)

Besides the Default Printer icon appears on the Front Panel, the Print Manager, which appears

on the Workspace menu, gives you a way to monitor the printers connected to the network.  This

is a convenient tool to determine if something is wrong with a print job you have sent off.

Sometimes, due to printer malfunction, your job will not be printed.  Instead of trying to print the

file again, start the PrintTool and check the print queue to see if you job actually got there or to

see if the printer needs attention, e. g., more paper.
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2.6.7 Mailer (Dtmail)

Mailer is a windowed interface to electronic mail.  The Mailer icon is available on the Front

Panel.  You will find that you use this tool frequently to communicate with classmates, friends,

and instructors.  It can be used not only to facilitate communication but also to organize and

maintain the messages which you have received and want to retain.  A more complete description

of the Mailer will be available in Section 5.

2.6.8 AnswerBook2 Navigator

The AnswerBook2 product is Sun's online documentation system.  It uses a web-browser

interface that lets you view and print a variety of Solaris™ information, including SGML-based

AnswerBook™ collections, Display PostScript™ AnswerBook collections, and man pages.  The

AnswerBook2 product provides a robust search engine that lets you find information throughout

the documentation library.  When you have questions about how a particular tool works you

should be able to find references to it via AnswerBook2.

To Start the AnswerBook2 Navigator from the Front Panel:

•  Click the arrow above the Help control in the Front Panel.

•  Click the AnswerBook2 control in the Help subpanel.

Or, from the Programs submenu - Workspace menu.

3. Using the Text Editor (dtpad)

3.1 What is an Editor?

A text editor is a program which helps you create and modify files containing text.  The manual

you are reading is stored in a computer file and was created through the work of several different

people using different text editors.  An editor is really a fancy kind of typewriter where, instead

of typing characters onto a piece of paper, characters are typed and stored by the computer in a

file.

This manual describes two editors.  The current section describes the CDE editor called Text

Editor.  This editor has the advantage of being mouse based, quick to learn, and easy to use.  Its

disadvantage is that if you log into the system from a personal computer (perhaps from your

dorm room) you cannot use the editor - it can only be used if you are at a Sun workstation.  The

other editor is called Emacs (see Section 7).  Its advantages are that it provides considerable
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functionality through a single interface (you can examine directories, run and debug programs,

read and send email); since it is keyboard based (i.e., doesn't use a mouse) it can be used at a

workstation or from a remote personal computer.  The disadvantage of Emacs is that it is less

intuitive, and has a complex collection of commands by which it is used.  You will use both of

these editors in various computer science courses.

3.2 Opening and Closing Text Editor

3.2.1 To Open Text Editor

•  Or, open the Applications subpanel in the Front Panel and click the

Text Editor control.

•  Click the Text Editor control in the Front Panel if available:

Text Editor can also be started from the command line by typing this

command in a Terminal window:

dtpad filename &

The file name is optional.

3.2.2 To Close Text Editor

•  Choose Close from the File menu or press Alt + F4

3.3  Text Editor Window

Text Editor window has a control area and a text pane that you use to compose and edit your text

file.  The title bar of the Text Editor window always displays the name of the file you are editing

(or the word “UNTITLED” when you have not assigned a name to the file), and shows you the

directory where the file is located.  When you have made editing changes, or have not yet saved a

file, the word “edited” is displayed in parentheses following the file name.
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3.3.1 The Status Line

One item of particular value is the status line option in the Options Menu.  This allows you to

see what line number you are currently on, as well as jump to other lines.

When writing a program, you will often be told that there is an error of a particular kind at a

particular line in the program.  The line in the program is actually the number of the line in the

text file containing the program.  You can display the specified program line in the editor

window by first, turning on the Status Line option in the Options Menu, if you haven't

already done so, and typing the line number you desire in the space where the line number is

displayed. To have the cursor appear at the specified line number, press Return.

3.4 Cursor Movement

In any editor, there is a special position on the screen (the insertion point) where the next

character will be placed when a key is struck.  The position is made  known to the user by a

special mark, called the cursor.  The cursor is a black up-pointing triangle, or carat, which

appears between lines and pointing up to the point at which the character will appear.

It is often the case that you want to move the cursor from its current position to some other

position in the file.  There are several ways you can do this.  One way is to use the arrow keys

located on the numeric keypad on the right side of the keyboard.  As you can imagine, these keys

move the cursor from where it currently is to a new place in the given direction.  Another way to

move the cursor is to use the mouse and pointer.  You move the pointer to the new cursor

location and press the left mouse button.  This is the best way to move the cursor over a large

span; the arrow keys should be used only to move a very few character positions or lines.

The following are the keyboard cursor/scroll movement keys:

Key Cursor Movement

Up Arrow Up one line

Down Arrow Down one line

Left Arrow Left one character

Right Arrow Right one character

Control+Left Arrow Move left to previous word

Control+Right Arrow Move right to next word

Home Beginning of the current line

End End of the current line
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Control+Up Arrow Beginning of the previous paragraph

Control+Down Arrow Beginning of the next paragraph

Control+Home Beginning of the document

Control+End End of the document

Control+G To the Line field in the status line

Page Up Up one page

Page Down Down one page

Control+Page Up Left one page

Control+Page Down Right one page

3.5 Text Movement

It is usually the case that the text in a file will not fit on the screen at one time, even if you make

the editor window as large as possible.  We saw, in the last section, that the Home and End keys

will not only relocate the cursor, but will also change the text displayed in the window.  It is also

possible to change the text displayed in the window without moving the cursor.  The editor

window has a scroll bar on the right side.  The rectangular region with the gray up and down

arrows is called the elevator.  The position of the elevator on the cable, the gray line which passes

through the elevator vertically, indicates which part of the text file is being displayed in the

window.  To move the window down one line in the text file, place the pointer on the down

arrow (on the elevator) and click the left mouse button.  If you hold down the left button on the

down arrow you will see that the text moves up in the window quickly, one line at a time (so that

the window is moving down in the text).  Of course, the opposite happens when you press the up

arrow.

If you position the mouse pointer anywhere on the cable below the down arrow of the elevator

and press the left mouse button, you will scroll down by one page (i.e., one window's worth).  As

you can imagine, by placing the pointer above the up arrow on the cable your text will scroll one

page up.

3.6 Selecting Text

If you think about times you have written term papers, you should recall that what you often want

to do is to remove a sentence from here, move that paragraph to the end of the section, delete a

word, or replace a misspelled word.  These sorts of things are difficult when using a typewriter or

writing by hand, but are made easy with a good text editor.  In order to do the actions just
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described one must be able to specify (or select) the text to be moved, removed, or replaced.

You can select text in the following ways:

1. To select a character, move the pointer onto the character and single-click the left mouse

button.

2. To select a word, move the pointer onto the word and double-click on the left mouse button.

3. To select a single line, move the pointer onto the paragraph and triple-click the left mouse

button.

4. To select an entire file, quadruple-click the left mouse button.

5. To select any continuous body of text, move the pointer to the place where you want to begin

the select, and press the left mouse button, drag the pointer over the text you want to select,

and release the mouse button.

Having selected the appropriate section of text, one can make several types of modifications by

using the left-most section of the keyboard, containing eleven keys.  These keys are labeled with

the name of the function they provide.  In particular, we are interested in the keys labeled Undo,

Copy, Paste, Cut, and Find.  Their use is described in the following:

1. To delete a segment of text, i.e., remove it from the text file, select the segment using the

techniques described above and the press the Cut key.  When the Cut key is pressed, the

selected text is removed from the file, but is retained by the editor (until the Cut or Copy

key is pressed again) in the clipboard.

2. To move a segment of text, i.e., cut it from one place and insert it at another, select the

desired segment of text and press the Cut key.  Then move the insertion point to the point at

which the deleted text should be inserted and press the Paste key.  Pressing the Paste key

copies the text from the copy buffer to the current insertion point.  Since this pasting

operation does not delete the text from the clipboard, the same text can be pasted into as

many locations in the file as desired.

3. To copy a segment of text, i.e., duplicate the segment at another point in the text, select the

desired segment and press the Copy key.  This leaves the file unchanged but copies the

selected text into the clipboard.  Then proceed as in the case of moving a segment.  Move the

insertion point to the desired location and press the Paste key.

4. To replace some text with some new text, select the desired segment and then type the new

text.

5. To find the next occurrence of a particular segment of text, select the desired segment and

press the Find key.  This will search forward in the file and stop at and highlight the first

occurrence of the segment it encounters.  If there is no occurrence, the editor will beep and
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flash the window.  If you want to search backward in the file (back toward the beginning of

the file) then you press the Find key while holding down the Shift key.

Except for finding text, the operations listed above all make some modification to the text.  It is

not unusual to decide, after making a change, that you want to undo the change.  Pressing the

Undo key does this.  In fact Text Editor keeps track of the various changes you make and will

allow you to undo the changes in reverse order (most recent change undone first).  When you

save the file contents, this record of changes is erased.

3.7 The Control Area

The control area of the Text Editor has File, Edit, Format and Options buttons.  The Text

Editor pane has a pop-up menu (found by pressing the right mouse button while the pointer is

located in the text pane), which provides these same commands (plus a special Extras pull-right

menu).  The options obtained by choosing Edit are identical to those just discussed - the

keyboard buttons are probably more convenient to use for these operations.  The other options

are available only through the available menus.

3.8 The File Menu

The File menu contains options that you can use to load and save a text file and for other file-

related functions.

The New option is used to open an empty text editor pane.  The title bar will display “Text

Editor - UNTITLED” and if you made changes editing and have not yet saved them, a

dialog window will appear asking you to confirm or cancel the operation.

The Open... option is used to associate a specific file with the editor window.  When this

option is chosen, a dialogue window is displayed.  The user is to write into this dialogue window

the name of the directory and file to be associated with the editor.  Clicking the left mouse button

on the Open... button in the dialog window (or pressing the Return key) loads the file into

the editor and displays the beginning of the file in the text pane, replacing any existing text.

Notice that, unless you pin it up, the dialogue window disappears after the load operation is

complete.
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Selecting the Include... item displays a TextEditor - Include a File dialog

window.  Type directory and name of file you want to include, and click OK button to include

the file you specify at the current insertion point in the text pane.

Use the Save item to save the contents of the Text Editor pane in the directory and file named in

the header of the Text Editor window.  If “UNTITLED” is shown as the file name, use the Save

as... option.

Selecting the Save as... option will cause a TextEditor - Save as... dialog

window to appear.  Type the appropriate directory name and file name, and click the left mouse

button on the Save button to save the contents of the Text Editor pane.

Selecting the Print option will print a document.  The Print dialog window displays the name

of your system's printer and enables you to set printing options.  By default, your document is

printed on your system printer.  If desired, you can direct your job to a different printer.

3.9 The Edit Menu

The Edit menu provides standard editing functions which, as indicated earlier, are duplicated

by the keys on the left side of the keyboard.

•  Use Undo to undo the last editing action or all editing actions and restore what was there

before, depending on which item you choose from the Undo submenu.

•  Use Copy to store a copy of the selected text on the clipboard.  Only one selection can be

stored on the clipboard at a time.  If something is already on the clipboard and you do a copy

or cut, the contents of the clipboard are overwritten with the new information.

•  Use Paste to insert the contents of the clipboard at the insertion point.

•  Use Cut to remove the selected text and store it on the clipboard.  Only one selection can be

stored on the clipboard at a time.

3.9.1  Find/Change Command

The Find Command in the Options Menu includes options that allow you to search for a

specific text string, special characters, and delimiters, and when found to replace it with another

string.
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3.9.1.1 To Find Text

When selected this option, the editor displays a TextEditor - Find/Change dialog

window.  If you have a current selection, it is automatically displayed in the Find text field.

Otherwise you should enter the string to be found in the Find text field.  At this point you have

several options based on the buttons you find on the dialog window.  To find the text string and

select it, simply click the left mouse button on the Find button.  Click on the Find button

again to find and select the next occurrence of the text string.  You will have recognized that this

functionality is the same as supplied by the Find key.

3.9.1.2 To Find and Change Text

To replace the current selection with another text string, type the text for the replacement string

in the Change To field and click the left mouse button on the Change button.  You can use

the Change button together with the Find button to find a string and then replace it with

another, or separately to replace highlighted text.  You can replace a string with nothing by

leaving the Change To text field blank.  The buttons at the bottom of the Find/Change

window combine find and replace operations, allowing you to Find then Change, Change then

Find, or Change All.  Caution - There is no Undo for Change All.

You can specify whether you want the find and change operations to apply to all of the text, or

restrict the operation to the text between the insert point and the end of the document by using

the abbreviated menu button to select either All Text or To End.

The Find/Change facility is very useful for all kinds of text processing.  When writing a

program, you may decide that a particular variable name should be changed.  Since it may appear

many times throughout the file, Find/Change is convenient for locating all occurrences and

properly replacing them.  The Find/Change facility is also useful for correcting spelling errors

in a file.

3.9.2 Spelling Checker

You can correct misspelled words with the Spelling Checker.  You can also customize your

Personal Dictionary and Main Dictionary.
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Choose Check Spelling... from the Edit menu.  The Spelling Checker dialog window

displays misspelled or unrecognized words and lists suggestions for them.  Take action on the

first word found by the spelling checker:

•  If the suggested replacement is correct, click Change to correct this occurrence, or

Change All to change all occurrences. (You cannot Undo a Change All.)

•  If you see the correct replacement in the list, select it and click Change or Change All.

•  If the correct replacement is not in the list, type it in the suggestion field and click Change

or Change All.

•  If the word is correct and you want to add it to your Personal Dictionary, click Learn

Word.

•  If the word is correct but you do not want to add it to your Personal Dictionary, click Skip to

skip this occurrence, or Skip All to skip all occurrences.

3.10 The Format Menu

Once your editing is complete, format your document by choosing margins and text alignment.

There are three options under Format Menu: Settings, Paragraph and All.

To Format a Document:

1. Choose Settings from the Format menu.  Format Settings dialog box

2. Enter margins.

3. Select left, right, justify (block style), or center alignment.

4. Determine the scope of the formatting:

•  To format a single paragraph, place the cursor in the paragraph, then click Paragraph.

•  To format the entire document, click All.

5. After closing the dialog box, choose Paragraph or All from the Format menu to apply

the settings.

4. The UNIX Operating System

An operating system is a specialized collection of programs which, when running on a computer,

manages the facilities of the computer and makes the facilities available, via a command

structure, to the computer's users.  A computer's facilities typically include hardware devices

such as keyboards, video displays, external storage such as disk and tape drives, printers, and

network connections.  The operating system makes it possible for the user to create and manage

files containing data or programs, display data files on a printer or video display, and send and
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receive electronic mail.  A user's interaction with the operating system is usually with a keyboard

(to type commands) and video screen (to see the computers response to the command).

The operating system, which runs on the SUN workstation, is named UNIX and is available on

many different types of computers.  The purpose of this section is to describe the basic command

structure for the UNIX operating system and to familiarize you with those UNIX commands that

are necessary for your workstation work.

4.1 Interacting with UNIX

When UNIX is waiting for the user to enter a command, it displays what we call the UNIX

prompt.  The prompt is a sequence of characters on the video display (possibly a shell window)

which is really a request from the operating system to the user to enter another command.  A

typical UNIX prompt could be

algol 41 % _

When you look at your screen, you will see the name algol replaced by the name of the

machine (or host) you are using.  The number following the host name is the number of the

command you are about to enter.  Thus, after each command is executed, the next prompt will

have a number one greater than the number of the previous command.  These numbers can be

used in conjunction with the UNIX history facility (See Section 4.10.1).  When a prompt appears

on the screen you will also see an insertion point one space past the % sign.  When you type a

command this insertion point is where the characters will appear (the ‘_’ represents the insertion

point.  For example:

algol 41 % date_

 To issue a date command, you press the Return key.  If that were done in the previous

example, you would see on your screen something similar to the following:

algol 41 % date

Tue July 17 17:03:23 EDT 1997

algol 42 %

Notice that the next prompt appears automatically when the last command has completed.  In

what follows you will see that all UNIX prompts are given as

host-name # %

Without the host name or command number specified.
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In UNIX, it is important to remember that the commands are usually in lower case letters.

Therefore, ‘date’ works but ‘DATE’ does not!  We say that UNIX is case sensitive. Try both

‘date’ and ‘DATE’.

host-name # % DATE

DATE: Command not found.

host-name # %

Some commands have options that are specified by a minus sign followed by characters.  For

example, ‘date’ may have the ‘-u’ option that displays universal time or Greenwich Mean Time.

host-name # % date -u

If you spell the command name correctly but supply an improper option, an improper argument

or the wrong number of arguments, many of the commands will not give you an error message

but only display a brief description of usage.  The command assumes you mistyped something

and need some assistance.  Try an incorrect option for date and you will see an example of a

usage message:

host-name # % date -p

date: illegal operation --p

usage: date [-u] mmddHHMM[[cc]y]

date [-u] [+format]

date -a [-]sss[.fff]

If you ever receive a ‘usage’ message, you typed something wrong.  In a usage description, the

square brackets ‘[ ]’ means that part is optional.  Obviously from date's usage message, it allows

several other features.

4.2 Changing Your Password

The first time you log in you may want to change your password from the one given you by the

computer center to one of your own choosing.  A word of warning, it is important not only to

choose a password which you can remember, but one which another user will not be able to

guess.  Your password is a security device that ensures only you have access to your files.  To

safeguard against unauthorized use of your account, be sure that you (and only you!) know your

password.  Your password should contain at least 6 characters and should not be a word

contained in a dictionary.  An easy way to meet this guideline is to choose some obscure or
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nonsense word (names are not good choices) replace one of the characters with a digit and

reverse the order of the characters. Instead of using ‘tempest’ use ‘tsepm4t’ [notice the ‘4’ key is

close to the ‘e’ being replaced].

To change your password use the mouse to move the pointer to the inside of a window where a

UNIX prompt, i.e., the host name followed by a number followed by a percent sign, is displayed.

Set your password by typing passwd -r nisplus at the UNIX prompt and press Return.

When you press the Return key, you will be asked to type in your old password.  After entering

your old password, you will be asked to enter the new password; after entering the new

password, you will be asked to verify it by entering it again.  If you don't type the same password

the second time or if you incorrectly typed your old password, the system will print an

appropriate error message and your password will not be changed.  If this happens, just start over

by typing passwd -r nisplus again.

host-name # % passwd -r nisplus

passwd:  Changing password for username

Enter login(NIS+) password:

New password:

Don't forget your password! Don't tell anyone else your password!

4.3 Files and File Commands

Data is stored in a file.  A file can contain a program (a list of instructions for the computer to

follow), data, or the text of a paper.  A file is like a piece of paper on which you can put lots of

characters, in any order.  One of the primary functions of the UNIX operating system is to

maintain user files, making sure that each user has access to their own files whenever necessary.

Files can be created in several ways.  You can create the file, say using an editor.  Programs can

create files.  For example, the Pascal compiler creates files.  It is easy to create files in UNIX.

The purpose of files is to store information for later use.  UNIX stores your files on a disk drive

in the network server until someone removes them.  Thus, if you create a file on one day, you can

count on it being there the next time you need it.
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4.3.1 File Names

So that you can tell your files apart, you give a name to each one you create.  When you create

files, you should give them names that are meaningful to you.  File names can contain most

printable character, but to avoid pitfalls, you should use only letters, digits, dashes, periods and

underscores.  The following are legal file names: lab1, LAB3, Lab1, Alongname, read.me,

program1.p

Remember that capital letters are different from lower case ones in UNIX.  Therefore, Lab1 is a

different file name from lab1.

4.3.2 What are Directories?

It is obvious that with so many people using the SUN workstations, there are a huge number of

files on the disk drive.  One needs a way to organize all of them as well as keep peoples' files

separate.  UNIX does this with directories and sub-directories  (directories inside of directories).

When you are given a UNIX account, your login is associated with a directory file.  When you

login you are placed in this directory which is called your home directory.  Your home directory

is a file that contains a list of all of your files (if any) and a list of all your sub-directories (if any).

When you are in a directory, say your home directory, and you create a file, it is placed in that

directory.

So that the UNIX system knows which files are yours, it associates your computer account with

your home directory.  The files in your home directory and sub-directories are yours; no one else

can create, change or remove them except you (or someone who has superuser privilege like the

Systems Administrator).

Your home directory makes accessing file easy for you.  The only names you have to worry about

are the names you give your files.  UNIX handles the rest.

Sub-directories are used to organize your files much like file folders are used to organize a heap

of documents.  For example, you might place all the files for your labs in a sub-directory called

‘labs’ and your programs in another one called ‘progs’.
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4.3.3 File Suffixes

Some commands in UNIX require an identifying part of the file name called a suffix.  This suffix

is part of the file name and contains a period followed by a single character or several characters.

For example, the Pascal compiler requires the .p suffix in the file name.  Therefore, prog1.p is a

file name that would contain a Pascal program.  Some popular suffixes follow:

.c for a C program

.cc for a C++ program

.f for a FORTRAN program

.h for a header file

.o object file (created by compiler)

.p for a Pascal program

.tex for a TeX document

4.3.4 Using Wildcard Characters in Filenames

A wildcard character is a symbol that you can use with many UNIX commands to specify more

than one file.  In UNIX, the wildcard character is the ‘*’ and it matches zero or more characters

in that place of the filename argument.  Therefore, ‘b*.p’ matches all files starting with b and

ending with the suffix .p.  You could list all the Pascal program files in a directory starting with b

by typing:

host-name # % ls b*.p

You can use more than one wildcard in a filename argument as shown below:

host-name # % ls do*at*

That would list the following files:  doat, doat21, doormat, dogcatcher and documentation.

4.3.5 Copying Files

One way to create a file is to copy an existing file.  The UNIX command to copy a file is cp.

After the command you type the file to be copied and a new file name.  Copy two files into your

directory by doing the following:  (Again, remember to keep the mouse pointer in the window in

which you want to type.)

host-name # % cp ~cs203/examples/humpty  myhumpty

host-name # % cp ~cs203/examples/jack_theory .
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 In the first line we copied a file called humpty in the sub-directory examples under cs203’s

home directory (~login_name is a user's home directory and cs203 is a login_name) and placed

the contents of the file into a newly created file called myhumpty.  The second line is the same

except that we were lazy and typed a period that tells UNIX to use the same name.  You made no

changes to cs203’s existing files.

The long string of directory/sub-directory/filename is an example of a pathname that is how you

specify any file on the system.  Many commands take pathnames as possible arguments  (see

Section 4.4.5 for more on Pathnames).

The command cp may use a wildcard character in the filename argument.  You could have

copied all of the files in my examples directory by doing the following:

host-name # % cp ~cs203/examples/*  .

Here the period is important to give each file the same name.

4.3.6 Listing Files in Your Directory

Now try listing your directory by using the command ls and the two files should be there.

host-name # % ls

myhumpty jack_theory

Try ls with the -a option.

host-name # % ls -a

You should see several file names which begin with a period, for example a .cshrc file.  These

dot files control how your system looks when you login and were placed there by the Systems

Administrator.  If you remove or alter these files improperly you will really mess up your screen

or find you can't even login!  If this should ever happen see your instructor immediately.  Later,

when we are more advanced, we may alter some of these files, but carefully!

Try ls with the -l option to list the files in extended form.

host-name # % ls -l

You can combine the two options by typing -al.

host-name # % ls -al
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You can also list a filename or a filename argument with a wildcard.  For example, you could list

all the files starting with ‘lab’ by:

host-name # % ls lab*

4.3.7 Displaying the Information in a File

The command ‘more’ followed by the filename displays the contents of that file.  Try ‘more’ on

myhumpty and jack_theory.  Hit the spacebar to display the next window full.  While using

‘more’ on jack_theory press an h and read the on-line help of the commands available in

‘more’.  Hit the spacebar to get out of the help display.  To go back a page, type “b.”  To quit

type “q.”  Using the command ‘cat’ can also complete this operation.  However, the latter

command scrolls through the entire document without page pausing.  Note this command would

not be desirable for displaying long documents.

host-name # % more jack_theory

host-name # % cat jack_theory

Like most commands that take a filename argument, ‘more’ allows a wildcard character (the

‘*’).  Therefore, we could be lazy and type:

host-name # % more j*

host-name # % cat j*

That will do ‘more’ on all files in the current directory beginning with “j.”  In this case, there is

only one: jack_theory.

4.3.8 Removing Files

Many times we need to clean up our directories and we desire to remove some files.  The

command rm removes or deletes the file specified by the filename.

Copy your file myhumpty to several new file names, say junk and baloney.  Then remove

junk and baloney from your directory.  Using ls, check that they were removed.

host-name # % rm junk baloney

host-name # % ls

It is important to realize that when you remove a file it is gone forever!  Therefore, to avoid

inadvertently deleting the wrong file, type carefully when you use rm.  The command rm allows
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a wildcard but you should be very careful when you use it or you will remove files you wanted to

keep.

4.4 Using Directories

Using directories is easy.  Most users after becoming comfortable with the SUNs use many

directories to organize their files.  For example, you could make a new directory for each new

programming assignment.

4.4.1 Making a New Directory

To create a new directory, use the command mkdir which stands for make directory.  The

conventions for names of directories is the same as the names of files, i.e., you should use letters,

digits, dashes, periods and underscores.  From your home directory make two directories (also

called sub-directories) named labs and progs.

host-name # % mkdir labs

host-name # % mkdir progs

Check using ls -l to see that they were created.  The ‘d’ in the first column means they are

directories.

4.4.2 Moving Between Directories

The above diagram shows the structure of the three directories and the two files we have made so

far.  [We are not showing the dot files.] To change the current working directory to a new one,

use the cd command.  To change to the labs directory type:

host-name # % cd labs

Try an ls command now.  You will see no files as you haven't created any in this directory.  To

return to your home directory you use the home command or just cd and no file name.

host-name # % home or host-name # % cd

home

labs progs jack_theory myhumpty
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4.4.3 Moving or Renaming a File

When you copy a file you end up with two files - the original file and the new one.  Sometimes

you may wish to move a file to another directory or keep it in the same directory but with another

name.  The command mv (for move) does both.

Move to your home directory if you have not done so.  Move the file jack_theory from your

current directory to the labs directory by typing the following:

host-name # % mv jack_theory labs

Using the cd command, change your working directory to labs and check that jack_theory is

there.

4.4.4 What is My Current Working Directory?

You can always tell what is your current working directory by using the pwd command (print

working directory).  Do that now.  pwd is a very useful and important unix command.

host-name # % pwd

Notice that pwd displays the whole pathname with something like:

/home/server-name/students/initial_letter/your-name/labs

That means your home directory is a sub-directory under students, which is a sub-directory

on server-name, etc.  Change your current working directory to your home directory and try

pwd there.

home

labs progs

jack_theory

myhumpty
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4.4.5 Using Pathnames

Most if not all the UNIX commands that use a filename can also take a pathname.  A pathname

is a string of directory names separated by ‘/’s where the last entry is a file name.  The full

pathname specifies where a file resides.  You can see the full pathname when you type a pwd

command.  However, you don't need to use the whole pathname most of the time.  There are

shortcuts that we will describe below.  If you are in your working directory (in this case your

home directory) and want to display the contents of jack_theory in the sub-directory labs, you

could use ‘more’ with a pathname.

host-name # % more labs/jack_theory

From your current working directory you can go ‘down’ the directory structure by using the

directory name, a ‘/’ and file name.  You can go ‘up’ the directory structure by using ‘..’s.  For

example, change your working directory to labs and type the following:

host-name # % more ../myhumpty

We could also have used “~” to specify your home directory because myhumpty is in your home

directory.

host-name # % more ~/myhumpty

You can have as many layers of directories as you want.  Make a new directory called lab1 under

labs.

host-name # % cd  ~/labs

host-name # % mkdir lab1

As another example of using pathnames, we will copy a file in the home directory to the new

lab1 directory two different ways.  First, while in the home directory we will issue the cp

command to make a copy of myhumpty called humpty1 and place it in the directory lab1.

host-name # % home

host-name # % cp myhumpty labs/lab1/humpty1

Now we move to the lab1 directory and copy the file from there and name the new copy

humpty2.

host-name # % home

host-name # % cd labs/lab1

host-name # % cp  ~/myhumpty  humpty2
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Move to the lab1 directory and make sure the two humpties are there.

For a final example, we will move jack_theory from labs to progs with the same name.

Assuming we are in the labs directory, we go ‘up’ one directory with ‘..’ and ‘down’ another by

specifying the directory name.

host-name # % cd  ~/labs

host-name # % mv  jack_theory  ../progs/.

Above are the directories and files we have now.  It is important that you understand how to

move around in directories and how to specify the correct pathname.  If you are still confused in

any way, go over this section again carefully studying the commands and using the diagrams.

4.5 Reading the On-line Manual Pages

UNIX has manual pages stored on-line for each command.  The command man followed by the

command name displays these reference manual pages.

To read the manual pages on the command man, type the following:

host-name # % man man

Since the command man uses ‘more’ to display the text, you use ‘more’s commands to get

around, i.e., the space bar for the next page, b to go back a page, and q to quit.  The manual

pages are not written for the beginning user.  Therefore, the beginner needs to learn how to

home

labs progs

jack theory

myhumpty

lab1

humpty1 humpty2
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extract useful information by selectively skipping over sections and ignoring large portions.  Try

reading some other man pages, say for ls and cd.

If you don't know the command you want but want to find an appropriate one, you can try a

keyword search of man.  Using the -k option and the keyword does this.  Say you want to copy a

file but can't remember the command.  Trying ‘man copy’ gives the message “No manual

entry for copy” that means there is no command spelled “copy”.  We could try the following

keyword search:

host-name # % man -k copy

And find lots of commands that do copying including cp that is what we wanted.

4.6 Printing Files

The printing of files is easy.  To print a text file (a file which you can edit), you use the lp

command where you specify the printer and the name of the file.  The default printer is the line

printer in room 350 Dana.  For all the other printers you must specify the printer name.  To print

the Pascal source file called myprog1.p you type the following:

host-name # % lp myprog1.p

4.6.1 Printer Names

An option -d and the name of the printer specify the different printers.  The names of the

printers are the following:

lw laser writer printer in 314 Dana (specifically for Jr/Sr CS Majors).

lw3 laser writer printer in 350 Dana.

lwc laser writer printer in 231 Dana.

lobby laser writer printer in Dana lobby.

For example, to print a letter to Mom on the laser printer in room 350 Dana, you would type the

following:

host-name # % lp -dlw3 letter.mom

The command lp only prints what's in the file.  It does not include the date or even the filename!

One uses the pr command to add the date, time, name of file and page number at the top of each

page.  Normally one uses the following for printing programs and output which is to be handed in

for a class.
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host-name # % pr myprog1.p | lp

In the above, pr formats the Pascal file myprog1.p and pipes (Read about pipes in Section

4.10.6 on “Pipes and Filters.”) the formatted output to lp to be printed.  You may choose the

alternate two columns output format for your submission. You would type the following to

submit your homework:

host-name # % a2ps -Plwc myprog1.p

4.6.2 Checking a Printer Queue

Since several people may request to print a file on a printer at the same time, your request is

placed in a queue (Queue is British for a line in which you wait like the McDonald's line in

Moscow.)  You can display the contents of a printer's queue with the lpstat command where

you specify the printer name by using the –o (lowercase letter o) option.  To check the queue of

the laser printer in room 350 Dana, you would type.

host-name # % lpstat –o lw3

4.6.3 Removing Requests From a Printer Queue

At times you find you may need to remove a request from a printer's queue.  Perhaps, you

discover that you printed the wrong file and don’t want to waste paper.  First, perform a lpstat

command and notice the job ID of the print request to be removed.  Then issue a cancel

command specifying the job ID.  Below we remove job ID lw3-20 from the line printer queue.

host-name # % cancel lw3-20

On rare occasions, a print request will hang the printer.  If there are print requests in the queue

and the printer has not printed for many minutes, perhaps the first (top) job in the queue is sick.

After checking that the printer is turned on, has paper, not jammed, is on-line, etc., then remove

the first job from the queue with cancel.  You can remove only your own printer requests.  If

the first job is not yours then you need to find that person or report the problem to the Systems

Administrator.

4.7 Other UNIX Commands

This section covers some UNIX commands that are important but infrequently used.
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4.7.1 Grep - Searching a File For a String

To search for a word, a phrase or any string of characters in a file use the grep command.  You

specify the string of characters then the file as shown.

host-name # %  grep  'Humpty'  humpty

Humpty Dumpty sat on a wall.

Now Humpty's unscrambled and good as new.

Two useful options for grep are -i that ignores the case of letters and -n that displays the line

numbers at the front of the line.  Here is the output after one asks grep to find all occurrences of

‘and’ including both upper and lower case letters and displaying the line numbers.

host-name # % grep -i -n ‘and’ jack_theory

37: This is Chaotic Confusion and Bluff

46: This is the Cybernetsics and Stuff

47: That covered Chaotic Confusion and Bluff

49: And thickened the Erudite Verbal Haze

57: To make with the Cybernetics and Stuff

58: To cover Chaotic Confusion and Bluff

60: And thickened the Erudite Verbal Haze

69: That made with the Cybernetics and Stuff

72: And, shredding the Erudite Verbal Haze

77: And Demolished the Theory Jack built.

As with many UNIX commands, grep can take a wildcard for the filename. (see Section 4.3.4

on “Using Wildcard Characters in Filenames.”)  Here we search for ‘to’ in all the files of the

directory.

host-name # % grep -i -n 'to' *

humpty:3: The King set the Tme Machine back to two.

jack_theory:56: This is the Button to Start ther Machine

jack_theory:57: To make with the Cybernetics and Stuff

jack_theory:58: To cover Chaotic Confusion and Bluff

jack_theory:68: Who pushed the Button to Stzrt the Machine

Notice that it displayed the filename before the line number.
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4.7.2 How Much Disk Space Am I Using?

All student accounts are limited in the amount of disk space (called disk quota) that they may

use.  This is typically two megabytes (or two million characters).  If you exceed this limit, you

won't be able to create new files.  Now two megabytes is a lot of disk space so most students

need not worry about exceeding it.  However, there are always packrats who save everything!  If

you do exceed your quota, you must delete some files.  You can tell how much disk space you

are using by issuing the du (disk utilization) command in your home directory.

host-name # % home

host-name # % du

du displays the amount of disk space used for each of your directories in kilobytes (thousands of

characters).  A megabyte is 1000 kilobytes.

To see what your disk quota is use the quota command.

host-name # % quota -v

Doing an ls -l in a directory will show the size of each file in bytes.  The size is the number

before the date.

-rw-r--r--   1 cs203    cs203        245 Aug 14 14:16 humpty

-rw-r--r--   1 cs203    cs203       2147 Aug 14 14:16 jack_theory

My file humpty is 161 bytes long and was last changed Aug 14, 1998.

4.7.3 Changing Permissions on a File

When you do an ls -l command, the current permissions are displayed for each file.  The first

10 characters are the permission fields for that file.  A ‘-’ in column one means a plain file.  A ‘d’

in first column means a directory.

-rw-r--r--   1 cs203    cs203        245 Aug 14 14:16 humpty

-rw-r--r--   1 cs203    cs203       2147 Aug 14 14:16 jack_theory

The next nine characters are grouped into three characters each (rwx, r-x and r-) for the

permissions for owner, group and world respectively.  The owner of the file is the login name

that created it.   In the above, both files are owned by cs203.  The three characters for the owner's

permission are ‘rwx’ which means the owner can read, can write and can execute the file.  The

Systems Administrator determines which login names are in a group.  In this case, others in
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cs203's group can read and execute the files but can't write or changed them.  The world is all

others on the system.  Anyone can read the files but can't changed them or execute them.

For a directory, execute permission is interpreted to mean permission to search the directory.

The permissions and file modes are summarized as follows:

r or '4'  the file is readable;

w or '2'  the file is writable;

x or '1'  the file is executable;

-  the indicated permission is not granted.

The chmod command allows the owner to change the permissions on a file.  The form of chmod

is:

chmod <who><op><permission> filename

where <who> is a combination of:

u       User's permissions (owner).

g       Group permissions.

o       Others (world).

a       All, or ugo.

<op> is one of:

+       To add the permission.

-       To remove the permission.

<permission> is any combination of:

r       Read.

w       Write.

x       Execute

A few examples, will help you to understand how to use chmod.  To set the file humpty so no

one but the owner can read, write or execute it, we would type the following:

host-name # % chmod go-rwx humpty

Note: no spaces are allowed in ‘go-rwx’.  Doing an ls -l humpty shows the following

permissions.

-rwx------  1 cs203          161 Jul 30 16:30 humpty

To set humpty's permissions back to what they were before, we need to do two chmod

commands.  One for the group and another for others.



43

host-name # % chmod  g+rx  humpty

host-name # % chmod  o+r  humpty

host-name # % ls -l humpty

-rwxr-xr--  1 cs203          161 Jul 30 16:30 humpty

If you want to hide all your programs so only you can read them, you could use a wildcard.  The

below changes all the files in the directory so only you, the owner, can read, write and execute

them.

host-name # % chmod  go-rwx *

Or you could have changed the permissions on the directory of where the files reside.

For instance, here are a few of the common ones:

644 is rw-r--r--

the owner can read and write the file or directory, everybody else

can only read it.

755 is rwxr-xr-x

the owner can read, write and execute the file, everybody else can

read or execute it.  For a directory, this mode is equivalent to

644.

711 is rwx--x--x

the owner can read, write and execute the file, everybody else can

only execute it.

4.8 Using the SUNs From a PC or a Macintosh

The SUNs may be used from a personal computer, say in your dorm room, or from a Macintosh

on campus.  However, the menus, mouse and multiple windows of CDE are not available.  But

you can use Emacs, compile programs, run programs, and do most UNIX commands.

4.8.1 Using the SUNs from a Public Macintosh

You can access SUNs from a Mac in two ways:

1. By using Telnet, a program that simply accesses the SUNs and gives you one window

interface.  You will not be able to use a mouse in that window.  And, you will not be able to

run any application that requires a window environment.

2. By using MacX a program that simulates X Windows.
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4.8.1.1 To use Telnet from a Mac

1. Open the Telnet folder by double clicking

2. Double click on NCSA/BYU Telnet 2.7 to run Telnet.

3. After Telnet's menus appear at the top of the screen, pull down File menu and select Open

Connection.  A session window will pop up.  Type in a SUN host-name, e.g.,

castor.eg.bucknell.edu or pollux.eg.bucknell.edu, inside the session

name box.  Then click on Connect button.  You should see a new window which displays

the normal SUN login message with the SUN host-name on the header bar.

4. Login to the SUN as normal.  You will login without window environment.  Therefore, you

will only have one window and the mouse is inoperative.  However, the arrow keys still

work.

5. To use Emacs see Section 4.8.4.

6. To Logout and get off the Mac type “logout” as usual from  host-name prompt.  If UNIX

gives you the message “stopped jobs,” type “logout” again.  Now under the File menu,

select Quit.

4.8.1.2 To use MacX from a Mac

Assuming the Macintosh you are using has MacX installed!

1. Double click on MacX folder.

2. Double click on Links document.  (If you double click on MacX instead, select Close

“Untitled” from the File menu and then select Open option from the File menu.  When the

widow pops-up double click on Links.

3. Select sun from the Remote menu.

4. Type your account name (aka: user name, login name, email name) and hit Return key.

5. Type your password and hit Return key.

6. After about 30 seconds a command window will pop-up.

4.8.2 Using the SUNs from a Public Personal Computer

You can access SUNs from a PC in two ways:

1. By using Telnet, a program that simply accesses the SUNs and gives you one window

interface.  You will not be able to use a mouse in that window.  And, you will not be able to

run any application that requires a window environment.
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2. By using X-Win32 a program that simulates X Windows.

To use Telnet from a PC:

1. Turn on the machine and wait for it to boot up.

2. Go to the Start Menu and from Network Applications select Telnet.

3. An Open Session window will pop up.  Either select or type in the SUN host-name, e.g.,

castor.eg or pollux.eg, inside the host name box.  Then click on Connect.  You

should see a new window that displays the normal SUN login message.

4. Login to the SUN as normal.  You will login without OpenWindows.  Therefore, you will

only have one window and the mouse is inoperative.  However, the arrow keys still work.

5. To Logout and get off the Telnet type “logout” as usual from host-name prompt.  If UNIX

gives you the message “stopped jobs,” type “logout” again.  Now under the Session menu,

select Exit.

To use XWin32 from a PC:  (Assuming the PC you are using has XWin32 installed)

1. Click on the Start Menu button at the left bottom corner and holding the mouse button up to

: Programs and select X-Win32.

2. After launching X-Win32, the X-Win box should be at the bottom of the task bar.  Click the

X-Win box with the right-most mouse button to open the pull-up menu.  Highlighted

Sessions to open the session selection windows.

3. Select one of the sessions, e.g. castor_cmd.

The available sessions are:

•  castor_cmd

•  castor_dt

•  castor_Xterm

•  coral_Xterm

•  pollux_cmd

•  pollux_dt

•  pollux_Xterm

4. The castor_Cmd login windows will pop-up.

5. Type your account name (aka: user name, login name, email name) and the password and

click OK.

6. After about 30 seconds a command window will pop-up with a UNIX prompt:

castor{41}%

7. To Logout and get off the UNIX type “logout” as usual from  UNIX prompt to close the

command window.
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8. Click on the X-Win box with the right-most button to open the pull-up menu.  Select Close to

exit X-Win32.

4.9 Transferring files with the SUNs

4.9.1 How to use ftp on the SUNs

The ftp command invokes the Internet standard File Transfer Protocol (FTP), which enables

file transfers to and from a remote network site.

1. Type ftp plus the ftp server name

charcoal{1}% ftp ftp.eg.bucknell.edu

Connected to charcoal.eg.bucknell.edu.

220 charcoal FTP server (Version wu-2.4(4) Tue Feb 27 10:40:30 EST 1996)

ready.

2. Type anonymous as guest under Name

Name (ftp.eg.bucknell.edu:ecst): anonymous

331 Guest login ok, send your complete e-mail address as password.

3. Type your e-mail address as password

Password:

230 Guest login ok, access restrictions apply.

4. ftp> prompt should appear

ftp>

The most common ftp commands are:

?  - displays all the available  ftp commands

bye - terminates the FTP session with the remote server and exit ftp

cd - changes the working directory on the remote machine to remote-directory

dir - prints a listing of the directory contents in the directory

get - retrieves the remote-file and store it on the local machine

put - stores a local file on the remote machine

mget - expands the remote-files on the remote machine and do get more than one file

mput - expands wild cards in the list of local files given as arguments and do put more than one

file

To get more detailed information about ftp from the man page, simply type man ftp.

host-name #% man ftp
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4.9.2 Transferring files from a Mac to SUNs

There are two ways to transfer files between a Mac and the SUN:  one is by using FETCH, and

the other is by using CAP.  The advantages of using CAP are that the original formats of the

files, are preserved when transfer takes place from the Macs to the SUNs and it distinguishes all

the Mac files than the UNIX files.

4.9.2.1 Transferring files from a Mac to SUNs by using CAP

CAP 6.0 (Columbia AppleTalk Package for UNIX) is an AppleTalk tool, which implements a

library containing a portion of Apple Computer’s AppleTalk, protocols.  It includes a number of

applications that can be used to print to a LaserWriter, and mainly act as an UNIX based

AppleShare compatible file server.

The procedure for using CAP is as follows:

1. Select Chooser from the  menu.  Select AppleShare, and then select Engineering under

AppleTalk Zones.  Finally select charcoal as the file server and click OK.

2. Type in User Name and Password in the login window.

3. After logging onto charcoal, you may either select CapVolume which will directly go to

your CapVolume directory under your home directory; r select Charcoal which will go to

the root level on the charcoal server.

Note:

♦  If you select CapVolume, the CapVolume icon will display on your desktop.  Double

click on the CapVolume icon to open/display all the files under the CapVolume folder.

Now you can transfer files between your Mac and the CapVolume folder on the SUN by

dragging files.

♦  If you select Charcoal, the Charcoal icon will display on your desktop.  Double click on

the Charcoal icon to go to the root level of Charcoal.  By continuing double clicking to

open folders until you can access your home directory. Now you can transfer files

between your Mac and the SUN by dragging files.

4. To exit, drag either the CapVolume icon or Charcoal icon to the Trash Can.

SHORTCUTS:
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If you would like to transfer files directly to another directory under your home directory instead

of CapVolume or vise versa, here is what you should do:

1. Open the Charcoal icon first, then follow the path to find your own home folder.

2. Click (only one click, not double click) on your folder to highlight the folder.  Go to File -

Make Alias and create an alias of your own folder.  Click OK on the warning window.

3. The alias folder icon will display on the desktop.  Leave this alias folder on your desktop as a

shortcut to access your SUN directory.

•  Double click on the alias folder

•  Type in your Name and Password in the login window to login to Charcoal

•  Click OK and ignore the warning message.  Then the Charcoal icon will be on the

desktop.

•  After the Charcoal icon on the desktop, then double click and open the alias folder

4. You may also set any alias folder at any subdirectory level by using the similar procedures.

NOTE:  By defaults, after the file transferred to the SUN it becomes a binary (executable) file,

even it is only a text file.  The file permission needs to be changed afterward.

4.9.2.2 Transferring files between a Mac and the SUNs by using FETCH* 

1. Turn on the machine and wait for it to boot up.

2. Open Applications - Internet Tools - Fetch.

3. Double click on Fetch 3.0.1 (unless its updated).

4. Under the New Connection... window, use either castor.eg, or pollux.eg or for the

Host.

5. On a line that says: User ID:  delete all, and type your user name (aka login name, account

name).

6. On a line that says: Password:  delete all, and type your password.

7. On a line that says: Directory:  delete all, and hit OK key.

8. To get a file from the SUNs to the Mac:  double click on the file you want or highlighted the

file and click on Get File... button.

9. To put a file onto the SUNs from the Mac:  select the file and click on Put File... button.

                                                
* There is also a Fetch handout available from the CCS Help Desk
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♦  If the original file format is a text file, then change the Format to Text (Fetch may

automatically change to Text)

♦  If the original file format is an image file, then change the Format to Raw Data.

10. To end the session:  either close the session window or select Close under File menu.

11. To quit Fetch by selecting File - Quit.

4.9.3 Transferring files from a PC to SUNs

There are two options to transfer files between an IBM and the SUN.  The first option is to use

the FTP program from Network Applications, the second choice is to run the Windows95
built-in  ftp  program.

4.9.3.1 Transferring files from a PC to SUNs by using FTP from Network Applications

1. Turn on the computer.

2. Go to the Start Menu and from Network Applications select FTP.

3. The New Session window will pop-up.

4. On a line that says:  Hostname or address:   type in one of the server names (castor.eg,

or pollux.eg).

5. On a line that says:  Username:   type in your username.

6. On a line that says:  Password:  type in your password.  Then click Connect.

7. PC's Hard Drive files will be in the left window and SUN's files will be in the right window.

8. To copy a file from Hard Drive to your sun account:  click on the file in the left window and

click on the >>Copy>> button.

9. To copy a file from your sun account to Hard Drive:  click on the file in the right hand

window and click on <<Copy<< button.

10. To quit FTP, do Sessions - Exit.

4.9.3.2 Transferring files from a PC to SUNs by using Windows95  buildin ftp program

1. Turn on the computer.

2. Go to the Start Menu and select Run.
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3. Type ftp with the server name (castor.eg, or pollux.eg) in the Run window and

then click OK.

4. When ftp window pops-up, type in your username your password.  Then run ftp commands

after ftp> prompt.

5. To exit FTP, type bye at the ftp> prompt

ftp> bye

4.10 Some Useful Features of UNIX

4.10.1 Using history of Your Commands

Most users find themselves issuing the same command repeatedly during a work session.  Since

UNIX commands can be lengthy and subsequently tedious to type out, there are shortcuts to

repeating a command.  For these shortcuts, UNIX provides a history feature, which records the

last, several commands (typically the last 40) for each shell window (a window with host-

name % prompt).

To display the last so many commands, type history.

host-name # % history

Now if you have an alias set for the history command, you should be able to type just ‘h’.

host-name # % h

Was ‘h’ defined?  If not, you can add the alias later when we cover ‘dot’ files and command

aliases in the next two sections.

When you display the history, you will see an associated number with the commands you typed

before.  To redo a command, type “!” followed by the number (No spaces between “!” and

number!) For example to redo the command with 23.

host-name # % !23

To do the last command, you type “!!”.  You can redo the last command starting with a string by

typing “!” followed by the string.  For example to repeat the last use of ‘more’, you would type:

host-name # % !m
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4.10.2 Changing Dot Files

When you issue the ls -a command in your home directory, you should see a series of dot files

or filenames that start with a period. Below are some common dot files and their purposes.  You

may display them with ‘more’ to see what is in them.  Be sure you know what you are doing

before you make any changes!!

.cshrc The .cshrc file is executed every time you create a new shell

window (a window with host-name % prompt).  This is where to

place your own command aliases.  See next section.

.dt This dot directory sets features for CDE.

.login This file is executed whenever you login.  It sets up OpenWindows.

.openwin-init This file sets features for OpenWindows.

.openwin-menu This file sets up the features of OpenWindow's menu buttons.

.emacs This file is used by Emacs to set up features.

.mailrc This file sets up features for mail.  Here is where you would add

mail aliases and mailing lists.  For example, you have a friend

named Jim Dunkelberger whose login name is ‘dunklbrg’ and you

can never remember it.  You could add the line

alias jim dunklbrg

to your .mailrc file and address mail to him as ‘jim.’

4.10.3 Creating Your Own Command Aliases

It is very easy to customize your frequently used UNIX commands by adding aliases to your

.cshrc file.  Using ‘more’ display your .cshrc file in your home directory.  Notice that there

are some aliases already existed.  For example that you can type ‘lo’ for ‘logout’ and ‘m’ for

‘more.’  If you want to add your own aliases just edit this .cshrc file and you may use the

aliases already there as models.  Here are some examples:

alias cls clear

alias pinebox 'telnet pinebox'

4.10.4 Redirecting Input and Output

Redirecting the input to and the output (I/O) from a command is easy in UNIX. To send the

output of any command or program to a file instead of the screen, use >.
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For example, to place a list of the files in the current directory in a file called ‘myfiles,’ you

would type the following:

host-name # % ls > myfiles

Again for any command or program, to read input from a file instead of the keyboard, use <.  For

example, to input from a file called data for a Pascal program called ‘myprog’ type:

host-name # % myprog < data

The symbol >> operates much as > does, except that it means, “add to the end of the file.”

Redirecting input from a file and output to a file is especially useful with writing programs from

other computer languages.

4.10.5 Background Processes

Many commands, e.g., Emacs, don't finish after a few seconds and, therefore, tie up the window

in which you typed the command.  UNIX allows you to easily place the command (or program)

in the background and run by itself.  Then it is  no longer associated with the window where you

typed the command.  This allows you to continue using the window's screen and keyboard.  This

is called submitting a background process.  Processes are just instances of programs in

execution.  Any command (or program) can be submitted as a background process by adding “&”

on the end of it.  For example, to sort a large file and redirect the output to the file sort-output

and not tie up your window while doing it, one would type the following:

host-name # % sort large-file > sort-output &

Some commands when run under OpenWindows or CDE, e.g. Emacs, create a special window to

run in.  If run in the background, the window stays until you quit or kill it.

To see a list of your current processes including both foreground and background processes, type

the following:

host-name # % ps -ef

The ‘-ef’ are options to the ps command.  Do a man ps to read about all the options.

In desperation, you can kill a runaway or hung up process. Use the  ps -ef command to find

the process-id.  Then type the following:

host-name # % kill -9 process-id
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4.10.6 Pipes and Filters

Pipes and filters are some of the niftiest features of UNIX.  A UNIX command's output may be

redirected directly to another command's input by the pipe symbol |.  For example, to list a

directory with too many files to display in the window at one time, one can pipe the output of ls

into ‘more’ by the following:

host-name # % ls -l | more

This is similar to redirecting the output of ls to a temporary file then displaying the contents of

the file using ‘more’ as follows:

host-name # % ls -l > temp

host-name # % more < temp

host-name # % rm temp

The use of the pipe symbol | is a lot handier than using a temporary file especially since we tend

to forget to remove the temporary file.  Pipes are really handy as shown by the below examples.

To count the number of users on system, one could type:

host-name # % who | wc -l

where the -l (that's minus el) is an option to wc (word count) to only display the number of

lines.

To look for a particular user “cs203” when you do a ps command, type the following:

host-name # % ps -ef | grep 'cs203' | more

In the previous example, we would say that grep is a filter  as it filters or selects only portions

of the output. The command grep displays each line in which it finds the string (see Section

4.7.1 on “Grep - Searching a File For a String”).

Assume you have written a Pascal program that displays the names (last name first) of the
members of your organization but they are not in alphabetical order.  To sort the names and then
print them, you could pipe the output of the Pascal program to sort, then pipe its output to pr
to format it and then pipe its output to the printer.

host-name # % names | sort | pr | lpr

However, if you do this, make sure the amount of output to the printer is reasonable.
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4.11 “Help! My Computer Died!”

As stressed in the book Hitchhiker's Guide to the Galaxy by Doug Adams: DON'T PANIC!!

Here is a list of troubleshooting actions to try which range from the simple to the very drastic.

1. Your computer screen has gone blank.  Hit the space bar.  The SUNs have an automatic

screen saver which blanks the screen after so many minutes of inactivity.

2. Hit Return key.  Perhaps you forgot to hit Return after entering a response.

3. Move the mouse pointer to inside a window with host-name % prompt. Maybe you hit the

mouse by accident and moved the pointer out of the window.

4. Press Control c to stop a program or a command.

5. If none of the above works and a window appears hung up (Meaning no activity on screen or

from pressing  keys while pointer is in the window.) then you can Quit the Window.  Do this

by pressing the right mouse button while the pointer is in the bar of the window.  Move the

pointer to ‘Quit’ and release the button.

6. If you have a runaway program which is not a window and the above actions did not work,

you can Kill the Process.  A  process is an instance of a program in execution.  Use the ps -

ef command to determine the process id.  Then in a window with host-name % prompt

enter kill -9 process-id. This should destroy the running process.  Do a ps

command to check.  Note: you can only kill processes which you created.  You can not kill

ones created by others.

7. If none of the above cures the sick SUN, move to another SUN.

8. If several SUNs don't work, perhaps the network is down.  It is rare but it does happen.  If

during normal working hours, probably someone will fix it within a half an hour.  If late at

night and the network is still down after 10 minutes, go to bed and get some sleep!

9. If you can't login or your files are really messed up, contact your instructor.  You also may

either call x71460 or stop by the office in Dana room 230A for assistance.
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4.12 A Brief Summary of Some UNIX Commands

Files and Directories Commands:

ls - list files in current directory.

ls -a - list dot files in current directory.

ls -l - list files in current directory in full form.

pwd - print working (current) directory.

mkdir name - make new directory.

cd pathname - change to directory.

cd - change directory to home directory.

rmdir name - remove directory.

home - change current directory to home directory.

cat file - display a file; concatenate several files.

more file - display file on screen pausing at each screenful. Press

space to continue.  Press h for help.

cp file1 file2 - copy file1 to file2.

mv file1 file2 - move file1 to file2 (rename).

mv file dir - move file to directory dir.

rm file - remove file (delete).

du - disk space used (do in home directory).

quota -v - displays your disk quota or allotment.

chmod <who><op><permission>

file

- change permissions on a file.

Useful Commands:

a2ps -Pprinter file - prints file in two column format.

lp –dlobby file - prints file on laser printer in Dana lobby.

lp –dlw file - prints file on laser printer in room 314 Dana.

lp –dlwc file - prints file on laser printer in room 231 Dana.

lp -dlw3 file - prints file on laser printer outside room 350 Dana.

lpstat –o printer - list printer queue, printers are hp, lw, lwc, lw3.

cancel job- id - remove job from printer queue (get job-id from lpstat).

man command - displays manual page to screen (on-line help).

man - k keyword - displays one line of commands which contain keyword.

logout - to log off of UNIX.

script - to capture a work session in a file.
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exit - to end a script session. To end a rlogin session.

who - displays who is on your machine.

rusers - displays all remote users (all on the network). Control c

to get out.

rlogin hostname - remote login to another computer (exit to get off).

date - displays time and date.

wc file - word count of file.

cal - prints a calendar.

spell file - displays misspellings of the file.

sort file - displays file sorted alphabetically.

grep 'string' file - displays all lines in file containing the string.

history - history of commands you have typed (!number to redo).

ps - display your processes running on your machine.

ps - ef - display all processes running on your machine.

kill 9 process-id - kill a runaway process (get process-id with ps).

passwd -r nisplus - change your password  password.

5. The Mailer

The Mailer is a desktop application for sending, receiving, and managing your electronic mail

(email) messages.  It’s icon is available on the Front Panel and also can be selected  from the

Mail submenu in the Workspace Menu.  When the new electronic mail (e-mail) arrives, letters

will appear in the in-tray of the icon.

5.1  Starting Mailer

To open the Mailer to read or send mail by clicking the Mailer icon in the Front Panel.

5.2  Using the Mailer Main Window

The main window contains the following areas:

Message Header List Displays information about mail messages

Toolbar Contains buttons for tasks that you perform frequently

Sash Resizes the Message Header List and message view area

Message view area Contains header fields and message text
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Attachment list Displays icons of mail message attachments, if any

5.3  Mailer Toolbar Buttons

The Toolbar contains buttons that offer an alternative to using the menus for common functions.

Button Function

Delete Deletes the selected messages from the mailbox.

(There is an equivalent item in the Message menu.)

Next Displays the message that follows the currently selected one.

(There is an equivalent item in the View menu.)

Previous Displays the message that precedes the currently selected one.

(There is an equivalent item in the View menu.)

Reply, Include Message Opens a Compose window with the email address of the

recipient filled in, and the message body included.

(There is an equivalent item in the Compose menu.)

Forward Opens a Compose window with the text of the selected message
and its attachments, if any, loaded.

(There is an equivalent item in the Compose menu.)

New Message Opens a Compose window.

(There is an equivalent item in the Compose menu.)

Print One Prints one copy of the selected messages.

(There is an equivalent item in the Message menu.)

5.4 To Read a Mail Message

•  Use the Next and Previous buttons on the Toolbar

Or,

•  Select the message to be viewed from the Message Header List.  The text of the message

appears in the Message View Area.

Or,

•  Double-click on the message to open it into a separate window.

5.5 Deleting Mail Messages

In general, messages will remain in the Mailer unless they are explicitly deleted.

•  Select the message you want to delete.
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•  Choose Delete from the Message menu,

Or,

•  Click the Delete button on the Toolbar.

NOTE:  Once a message has been deleted, you can get it back unless you made your deletions

permanent by choosing Destroy Deleted Messages from the Mailbox menu.

5.6 Replying to a Mail Message

1. Select the message to which you want to reply.

2. Determine the scope of the reply.

•  To reply to the sender, click Reply button on the Toolbar or choose Reply from the

Compose menu.

•  To reply to the sender and all the recipients of the message, choose Reply to All

from the Compose menu.

•  To reply to the sender and all the recipients of the message and include a copy of the

message, choose Reply, Include Message from the Compose menu.

•  Type the reply message text in the Re:  dialog box.

•  Click the Send button or choose Send from the File menu.

The Compose window closes and the message is sent.

5.7 Sending a Mail Message

1. Choose New Message from the Compose menu or click New Message button on the

Toolbar.

The New Message window appears.

2. Type the email addresses (e.g. username@bucknell.edu for anyone at Bucknell) of the people

to whom you want to send the message in the To field and press Return.

You can send a message  to a single user, multiple users, or an alias.

3. Optional:  Type the topic or title of the message in the Subject field and press Return.

4. Optional:  Type the email addresses of the people whom you want to be carbon copy

recipients of the messages in the Cc field and press Return.

5. Type the message text in the text area.

6. Click the Send button or choose Send from the File menu.

The New Message window closes and the message is sent.
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5.8 Printing Mail Messages

It is often the case that you want to print a hard copy of received messages.  You can print a

message using the default options or set different print options.

To Print a Message with the Default Options:

1. Select the message to be printed in the Message Header list.

2. Click the Print button on the Toolbar or choose Print One from the Message menu.

To Print a Message with Specific Options:

1. Select the message to be printed in the Message Header List.

NOTE:  You can select several messages at once for printing by holding down the Shift

key before selecting each message with the mouse.

2. Choose Print from the Message menu.

3. Set the options you want to change:

•  Type a new printer name in the Printer field

•  Indicate the number of copies in the Copies field

•  Type a title for the banner page in the Banner Page Title field

•  Select Print Page Numbers to print page numbers in your document

•  Type command-line print options in the Print Command Options field

•  Click Print.

5.9 To Create an Alias

You may want to create an alias for a user or group of users to whom you frequently send mail.

1. Choose Alias from the Options menu in the main window.

The Aliases dialog box is displayed.

2. Type the name for your alias in the Alias field.

3. Type the user addresses that will make up the alias.

Each of the addresses should be in the form username@hostname and be separated by a

comma, space, or both.

4. Click Add to add the information in the Alias and Addresses fields to the Alias list.

5. Click OK or Apply to make the settings take effect.

To change an alias, select it and edit the Alias or Addresses field, as appropriate, then click

Change.  To remove an alias, select it and click Delete.
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5.10 Retaining and Organizing Mail Messages

One final useful feature of Mailer is a mechanism for retaining mail messages by category.

1 Select one or multiple messages.

To select multiple messages, either choose Select All Messages  from the Mailbox

menu or click and drag the mouse over multiple consecutive message headers.

2 Choose Save As Text from the Message menu.

3 Type a file name and location for your message in the Mailer - Save As Text dialog

box that appears.

4 Click Save or Append to either save the message to a new file or append it to an existing

file.

6. The File Manager

6.1 Using File Manager

The File Manager uses a graphical interface to assist users in managing their directories

(folders), files (documents) and applications.  The File Manager adopts icons similar to those

used in Microsoft  Windows95  and the Macintosh  operating system. You can use File

Manager to find, copy, move, open, close, delete, undelete, create, and print files.  You can start

applications from File Manager, and reorganize your file system by moving or copying files

between folders.  You can also use File Manager to link files and to transfer files to other

machines.

6.2  To Select a Single File or Folder

Mouse

•  Click once on the icon.

Keyboard

1. Use the Tab and Arrow keys to move the highlight to the icon you want to select.

2. Press Spacebar.

When a file or folder is selected, its name is highlighted.

To deselect a file or folder, select another icon or click on an empty area in the File Manager

window.
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6.3  To Select Multiple Files or Folders

You select multiple objects so that you can use one of the Selected menu choices on these

objects.  Selecting multiple files is useful if you want to delete several files at once, or move a

group of files to a new folder.

Mouse

•  Press mouse button 1 in a blank area of the view, drag the mouse to draw a box around the

icons you want to select, then release the mouse button.

Or, click to select the first icon, then hold down the Control key and click to select each

additional icon.

•  To remove a single icon from a selected group, hold the Control key and click on the icon

you want to deselect.

Keyboard

1. Select the first file or folder icon by pressing Spacebar.

2. For each additional icon you want to select, move the highlight to it, then press Control +

Spacebar.

6.4 To Rename a File or Folder

Mouse

1. Select the file or folder name by clicking on the name beneath its icon.  The name will be put

in a text field.

2. Type the new name.

3. Press Return.  If you just click outside the name when you are done, your changes will be

lost.

To cancel a rename operation, press Escape.

Keyboard

1. Use the Tab and Arrow keys to move to the icon for the file or folder you want to rename.

2. Press Spacebar to highlight the icon name.

3. Choose Rename from the Selected menu.

4. Type the new name.

5. Press Return.

To cancel a rename operation, press Escape.
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6.5 To Move a File or Folder

Mouse

1. Make the destination folder visible:

•  Open a File Manager view of the contents of the destination folder.

•  Or, open a File Manager view that shows the icon of the closed destination folder.

2. Select the file or folder to be moved.

3. Drag the file or folder and drop it onto the destination folder.

Keyboard

1. Use the Tab and direction keys to move the highlight to the file or folder to be moved.

2. Press the Spacebar to select the object

3. Choose Move to from the Selected menu.

4. Type a name into the Destination Folder: text box.  For example, if you want to move the file

report into the folder /u/john, you would type

/u/john.

5. Click OK or press Return.

6.6 To Copy a File or Folder

Mouse

1. Make the destination folder visible:

•  Open a File Manager view of the contents of the destination folder.

•  Or, open a File Manager view that shows the icon of the closed destination folder.

2. Select the file or folder to be copied.

3. Press and hold the Control key.

4. Drag the file or folder and drop it onto the destination folder.

Make sure that you release the mouse button before you release the Control key.  Otherwise,

you will move instead of copy the file or folder.

Keyboard

1. Select the icon.

2. Choose Copy to from the Selected menu.

3. Type a name into the Destination Folder: text box.  For example, if you want to copy the file

report into the folder /u/john, you would type

/u/john

4. Click OK or press Return.
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To close the Copy File dialog box without copying a file, click Cancel or press Escape.

6.7   To Delete a File or Folder (to the Trash Can)

•  Choose the Put in Trash command from the icon's pop-up menu (displayed by pressing Shift

+ F10 or mouse button 3).

•  Or, select the file or folder's icon, then choose Put in Trash from the Selected menu.

•  Or, drag and drop the file or folder's icon onto the Trash Can control in the Front Panel.

•  Or, drag a file or folder's icon to the open Trash Can window.

6.8  To Find a File by Name

1. Choose Find from the File menu.

2. Type the name of the file or folder you want to find into the File Name field.  You can use

wildcard characters to help locate a file or folder name.  For example, fe* will find all files

that begin with fe.  The searches are case sensitive.  If you type capital letters, it will only

find names with the same capitalization.

3. Type the name of the folder where you want to start the search into the Search Folder field.

(By default, this field contains the name of the current folder.)  Find will search this folder

and all it's sub-folders.

4. Click Start or press Return.

File Manager begins searching the Search Folder and the folders it contains for files that

match the name you provided.  Matches that are found are listed in the Files Found list.

Once you have found an object, you can press Open Folder to open the folder it is in, or

press Put in Workspace to place its icon on the current backdrop.

To stop the search, click the Stop button or press Return.

6.9 To View Files and Folders on a Diskette

1. Insert the diskette into a disk drive

2. Select Open Floppy from the Files control subpanel on the Front Panel.

 Or:

1. Insert the diskette into a disk drive

2. Open File Manager
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3. Select Open Floppy from the File menu

After selecting Open Floppy, if the diskette is formatted and readable by the system, File

Manager displays a view of the diskette's contents; if the diskette is unformatted or is unreadable

by the system, Format Floppy dialog box appears.

6.10  To View Files and Folders on a CD-ROM

 When you insert a CD-ROM into a CD-ROM drive, File Manager displays a window containing

a view of the contents of the CD-ROM.

If you close the File Manager window for the CD-ROM, you can reopen it by selecting Open

CD-ROM from the File Manager File menu or from the Files subpanel on the Front Panel.

6.11  To Rename a Diskette

From the diskette's File Manager window:

1. Choose Rename Floppy from the File menu.  The Action: Rename Floppy dialog box

appears.

2. Type the new name into the Floppy Name text field.

3. Click Rename or press Return.

6.12  To Eject a Diskette or CD-ROM

From the diskette's or CD-ROM's File Manager window:

1. Choose Eject from the File menu.

2. Remove the diskette or CD-ROM from the disk drive.

6.13 To Format a Diskette

From the diskette's File Manager window:

1. Choose Format Floppy from the File menu.

2. Select one of three formatting options (UNIX, MS-DOS, or NEC-DOS) in the Format Floppy

dialog box.

3. Click Format or press Return.
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4. Optional.  To rename the diskette, type the new name into the Floppy Name text field of the

Format Floppy dialog box.

7. The Emacs Editor

7.1 What is Emacs?

Emacs is a powerful full screen editor that is available on most UNIX systems.  It has many

advantages over other command based editors, such as ed and vi.  For example, Emacs has the

ability to automatically indent FORTRAN or C/C++ programs properly.  An advantage of

Emacs  over Textedit is that it can be used from a public Macintosh or a personal computer in

your dorm room.  The current version of Emacs used on the SUN workstations is GNU Emacs

20.6.1.

7.2 Starting Emacs to Edit a File

Before you start the next section, you should copy the file ‘stories’ into your directory. Type the

following to copy the file.  (see Section 4.3.5 if you need help in copying a file.)

host-name # % cp ~cs203/examples/stories stories

To run Emacs, type at a host-name % prompt the command Emacs followed by a file name

and ‘&’.  To create the new file named myfile type the following:

host-name # % emacs myfile &

The & sign tells UNIX that you wish to run this program in the “background” (see Section 4.10.5

on “Background Processes”).  Basically, what this does is give you the host-name % prompt

back to allow you to issue others commands in the window.

Since you probably don't have a file called ‘myfile’ in your directory, Emacs creates a new file.

You should see ‘(New file)’ at the bottom of the window.  Notice the black bar near the bottom.

It should tell you the name of the file, the time and other information.  And the black rectangle in

the upper left hand corner of the Emacs window.  This ‘cursor’ moves along as you type.  It is

important for you to distinguish between the mouse pointer and the cursor.  The pointer is used to

move between windows and to select items to click on.  The cursor is where you type text.  Each

Emacs and host-name % window has a cursor.  The cursor is a black rectangle when the

window is active and white when not active.
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Now you are ready to edit the file.  With the mouse pointer in the large area of the window, start

typing.  Don't worry about making mistakes.  We will fix them up in a few moments.  Type three

or four lines worth of text.  Use the four arrow keys (on far right side of SUN's keyboard) to

move the cursor around and insert text.  Make corrections by deleting the character to the left of

the cursor by using the Delete key.  You can also use the left mouse button to position the cursor

where the pointer is.

7.3 Notation for Emacs' Key Sequences

Emacs uses special sequences beginning with the Control and Esc keys.  The notation C-f

means to hold the Control key down and press the f key.  The notation M-f means to press the

Esc key once and then f.  Do not hold the Esc key down as that repeats the key.

7.4 Exiting From Emacs

To exit Emacs type C-x C-c and Emacs will ask you if you need to save any files.  Normally in

windows environment, we don't need to exit Emacs, we just close the Emacs window by

clicking on the left small rectangle at the top of the window.  This reduces it to a small icon on

the screen which we can open again with a click on the icon when we need our faithful friend

again.

7.5 Saving the Contents of the File

What you have typed for the file myfile has not been saved.  To save the file, type C-x C-s.  You

should see a message appearing at the  very bottom of the window saying Emacs ‘wrote’ the file.

This small area is where Emacs displays messages or requests input.  As you are developing a

program or typing in a data file, you should save it every few minutes.

7.6 Reading A File

You can read (find or load) a file after you are in Emacs by typing C-x C-f.  In the bottom small

area, you should see find file: ~/ where you type in the pathname of the file.  (For more

on pathnames see Section 4.4.5 “Using Pathnames”).  For now, you should type in ‘stories’ after

the ‘/’ and a file with stories should be loaded in the window for editing (If the stories file is

missing, you didn't copy it. Exit Emacs by C-x C-c and copy the file into your directory as
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described earlier in Section 7.2.)  Since you will be experimenting and modifying your own copy

of the file, feel free to modify it as you wish.

The stories file is too large to fit on the screen all at once.  Notice the black bar on the bottom, it

says ‘top’.  This means you are at the top of the file.  At other times by displaying a percentage,

it indicates  how far you are through the file.  When you are at the end, it says ‘bot’ for bottom.

If all the file can be displayed, then it says ‘all.’

7.7 Moving Cursor and Moving Text Within the Screen

To scroll forward a page, use C-v and notice that the percentage changes on the black bar.

Typical of Emacs, the reverse motion, i.e. to scroll backwards (M-v), is the same character

preceded by ‘M’ (stands for the Meta key which is ‘Esc’).  Below are some cursor commands to

try on the stories file.  Practice them all several times before going on.

Cursor Movement and Screen Motion

M-f       Forward one word.

M-b       Back one word.

C-e       End of line.

C-a       Beginning of line.

M-<       Beginning of file.

M->       End of file.

C-v       Scroll forward a page.

M-v       Scroll back a page.

7.8 Cutting and Pasting a Region of Text

To move a block of text, you first move the cursor to the beginning of the region and mark with

C-SPACE then move the cursor to end and cut the text with C-w.  Now you move the cursor to

the place where you want and paste with C-y.

To copy or duplicate a region of text is similar except instead of cut we copy with M-w.  Move a

whole story from one part of the file to another.  Copy or duplicate a saying or two.  The cut

operation can be used to delete a region as well.  Remove from the file any stories you don't like!

Here is a summary of the killing and deleting operations to practice on the stories file.

Killing and deleting

DEL       Delete character to left.
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M-DEL     Kill word to left.

C-k       Kill from cursor to end of line.

C-SPACE   Mark start of region.

C-w       Cut region (Kill region).

M-w       Copy region.

C-y       Paste region (Yank back last thing killed).

M-y       Yank back thing before last thing killed (do after

          a C-y).  Repeat to retrieve older text killed.

Notice the distinction between ‘deleted’ and killed.’  Deleted text can not be ‘yanked’ back or

retrieved while killed text can.

7.9 Recovering From Errors

You just typed an Emacs command and it didn't do as you wanted.  Perhaps, you deleted a large,

but the wrong, section of text!!  Keep your cool!!  While in Emacs you can undo it by C-x C-u.

You can continue to type C-x C-u to slowly undo your other changes.

Another cause of frustration is when you type in a wrong Emacs command but haven't pressed

the Return key yet.  You have great dread that this unknown command will wreak havoc on your

file.  Again!  Don't Panic!!  Just type C-g to cancel a partially completed command.  Try out both

of these features.

7.10 Using Auto-save's Backup Copy of File

If you do not save your file for several minutes, Emacs automatically saves the file (auto-save

feature) in a file name the same as yours with a ‘#’ before and after.  In case of disaster, e.g. the

electrical power goes out, you can retrieve the latest auto-save copy by copying that file to your

file.  Inside Emacs type M-x recover-file then type in the name of your file you want to recover.

Then you can save with C-x C-s to put the recovered text into the file itself.

7.11 Searching for Character Strings

Emacs has a character searching feature that is a joy!  It is called an incremental search as it finds

the next match from where the cursor is as you type in each character!  Type C-s and slowly type
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a common word such as ‘and’ to see this in action.  Press the delete key slowly to delete

character by character the word ‘and’ in the Emacs command area.

To find further occurrences of the string, type C-s repeatedly.  When you get to the end of the

file, C-s will wrap around to the beginning and continue searching.  To get out of search mode

hit the Esc key.  You can always search for the last thing searched by hitting C-s C-s.  C-r does

the same as C-s except the search goes backwards in the file.

7.12 Splitting the Screen and Multiple Files

Many times you would like to look at two different portions of a file but they both are not

displayed at the same time.  No problem for our versatile friend!  Emacs lets you split the

window into two parts horizontally by typing C-x 2.  Now both parts can be scrolled and

operated on.  For example, you may cut and paste from one part to the other.  You move between

the split windows by C-x o.  You remove all split windows other than the window with the

cursor by typing C-x 1.  You split the window vertically by pressing C-x 5.

A powerful technique is to use the split windows on two different files. Just move to the other

part and read (find) a file, say myfile. Again, you can scroll the two files and cut and paste

between them. You can also cut and paste between a file and your mail.

Here is a summary of the split and multiple window commands.  Practice them all.

Split Windows and Multiple Files

C-x 2     Split window in two horizontally.

C-x 5     Split window in two vertically.

C-x 0     Delete this window.

C-x 1     Delete all other windows.

C-x o     Switch cursor to other window.

7.13 On-line Help and On-line Emacs Tutorial

There is on-line help in Emacs which you will probably find a little advanced.  You receive the

help by C-h.  If you want some more practice with the Emacs commands, there is a very good

tutorial which you begin by pressing C-h t.
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7.14 Using Electronic Mail

Using electronic mail (email) is extremely easy and we encourage you all to check your email on

a daily basis.  When you login, the system will tell you if you have mail.  Also, if the flag of the

mailbox icon is up, you have mail.

7.14.1 Reading Your Electronic Mail

At any time while you are in Emacs, you can read or send mail then return to what you were

doing in Emacs.  To read your mail, enter Emacs if you are not already in it and just press C-x

C-r.

Once you have entered ‘RMAIL’  mode, you should see a message to read.  Press ‘n’ to see the

next message and ‘p’ for the previous message.  You can delete the message by pressing ‘d’ and

the next message is automatically displayed.  ‘u’ will undelete a message.  You may press ‘h’ to

see a header line for each of your messages.  If you want to jump to a specific message, you press

the number from the header line  followed by ‘j.’  You can place a message in a mail folder by

pressing ‘o’ and typing in the name of the file folder, say ‘mymail.’  You can place a message in

a UNIX file, in order to print, etc. by pressing C-o and supplying the name of the file.  You return

to what you were doing in Emacs by pressing ‘q.’

7.14.2 Sending Electronic Mail

To create a message and send it to someone you need to know their email address.  For everyone

on the SUNs, the email address is the login name.  Remember login names are usually all lower

case letters.

To send a message while you are in Emacs, you press C-x m.  Fill in after the ‘To:’ with the

person's email address (or several email addresses separated by blanks).  Then move the cursor to

the ‘Subject:’ field and type in a subject.  Now move the cursor to below the ‘-text follows this

line-’ and type in your message.  Do not delete or alter the ‘-text follows this line-’ string as

Emacs needs it.

You may use the power of Emacs to edit your message.  For example, you can cut and paste

blocks of text from a file into your mail message.  When you are ready to send your message,

type C-c C-c.  This also, returns you to what you were doing in Emacs.
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7.14.3 Replying to  Electronic Mail

When you are reading a message, you can reply by pressing ‘r’ and the window will be split in

two.  You proceed as in sending a message except the ‘To:’ field and the ‘Subject:’ field have

already been filled in.  Add your message below the ‘-text follows this line-’ line.  When you are

ready to send your message, type C-c C-c.

7.14.4 Reading One of Your Mail Folders

While reading your mail in Emacs, you may read a mail folder file where you have saved old

messages.  To do this press ‘i’ and type in the mail folder filename.  All the mail commands are

available, for example, ‘d’ for delete.  Type ‘q’ to quit reading the mail folder.

7.14.5 Summary of Mail Commands

Reading Mail (Press C-x C-r while in Emacs)

         n       Display next message.

         p       Display previous message.

         h       List of header lines of messages.

         j       Jump to first message.

 <number>j       Jump to message numbered <number>.

         d       Delete message.

         u       Undelete a message.

         r       Reply to message.

         o       To append message to mail folder file.

       C-o       To append message to UNIX file.

         i       To read a mail folder file. Supply file name.

         f       Forward the message to another person.

         g       Get newly arrived mail.

         q       To quit reading mail.

Sending Mail (Press C-x m while in Emacs)

    C-c C-c      To send the message and quit.
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7.15 Summary of Some Emacs Commands

On the following page(s) is a summary  of all the Emacs commands (not mail) mentioned in the

previous sections.

C-f means hold Control key down and press f.

M-a means press Esc key then press a.

Cursor movement:

C-f Forward one space.

C-b Back one space.

C-n Next line.

C-p Previous line.

C-a Beginning of line.

C-e End of line.

M-f Forward one word.

M-b Back one word.

M-< Beginning of file.

M-> End of file.

Screen Motion:

C-v Scroll forward a page.

M-v Scroll back a page.

Error recovery :

C-g Abort partially typed in command.

C-xu Undo an unwanted change.

Killing and deleting:

DEL Delete character to left.

M-DEL Delete word to left.

C-k Kill from cursor to end of line.

C-SPACE Mark start of region.

C-w Cut region (Kill region).

M-w Copy region.

C-y Paste region (Yank back last thing killed).

M-y Yank back thing before last thing killed (do after a C-y).

Repeat to retrieve old text killed.

Split Windows and Multiple Files:

C-x 2 Split window in 2 horizontally.

C-x 5 Split window in 2 vertically.
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C-x 0 Delete this window.

C-x 1 Delete all other windows.

C-x o Switch cursor to other window

General commands:

C-x C-c To quit Emacs.

C-h For help.

C-x C-f To find or read a file (used to create new ones too).

C-x C-s To save a file.

C-x i To insert contents of file.

C-x C-b List buffers.

C-s Incremental search for a string.

C-s for next occurrence. ESC to stop search.

M-x repl s To replace a string with another.

C-x C-g

or

(M-x goto-line)

To go to a line number.

8. Useful Tools in UNIX

8.1 Compressing Files

It is possible you may run out of disk space (see Section 4.7.2).  Rather than delete important

files, they can be compressed to save space.  To compress a file, you type:

host-name # % compress filename

The compress utility places the compressed form in a new file with .Z appended to the same

name and then deletes the original file.  A compressed file is typically half the size.  Type ls -l

to check the size.

To uncompress a compressed file, type the following:

host-name # % uncompress filename.Z

Now the original file is back with its original name and the .Z file was deleted.  Warning: never

try to edit or print a compressed file.
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8.2 Tar or untar Files

The tar utility is used to archive multiple files into a single file, as used in tape archives.  In this

way, the multiple files are transferred across the network as a single file.  This process eliminates

the time required to initialize each file transfer across the network or the Internet.  To create a tar

file, type:

host-name # % tar c ~/examples

After completing the command, a new file with .tar will be appended to the given filename.

In reverse, to extract  or “untar” the multiple files in the .tar file, type:

host-name # % tar x examples.tar

For other extensive options, consult the man page by typing man tar.

8.3 Backing up your files by using Snapshots

Our Network File System (NFS) file server, hydra, provides file system backup called snapshots.

A snapshot is an on-line, read-only copy of the entire file system.  Snapshots can be accessed by

users as read-only files to recover previous versions of files (for example, files that have been

accidentally changed or deleted).  This feature allows users to restore their own files without the

system administrator.  To ensure system security, files within a snapshot carry the same

permissions as the original files.

There is a “magic” directory named .snapshot which does not normally show up in a directory

listing under each user’s home directory.  There are also few sub-directories under .snapshot

based on the snapshot schedule.  The command to view the snapshots with access times is ls -

lu (Note:  ls -al will not show the correct date information).

charcoal{41}% ls .snapshot

hourly.0/   hourly.2/   nightly.0/  nightly.2/  nightly.4/  weekly.0/

hourly.1/   hourly.3/   nightly.1/  nightly.3/  nightly.5/

or

charcoal{41}% cd .snapshot

charcoal{42}% ls -lu

total 88

drwxr-xr-x  24 ecst staff       4096 Mar  5 08:01 hourly.0/

drwxr-xr-x  24 ecst staff       4096 Mar  4 20:01 hourly.1/
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drwxr-xr-x  24 ecst staff       4096 Mar  4 16:01 hourly.2/

drwxr-xr-x  24 ecst staff       4096 Mar  4 12:02 hourly.3/

drwxr-xr-x  24 ecst staff       4096 Mar  5 00:01 nightly.0/

drwxr-xr-x  24 ecst staff       4096 Mar  4 00:02 nightly.1/

drwxr-xr-x  24 ecst staff       4096 Mar  2 00:00 nightly.2/

drwxr-xr-x  24 ecst staff       4096 Mar  1 00:01 nightly.3/

drwxr-xr-x  24 ecst staff       4096 Feb 28 00:00 nightly.4/

drwxr-xr-x  24 ecst staff       4096 Feb 27 00:01 nightly.5/

drwxr-xr-x  24 ecst staff       4096 Mar  3 00:00 weekly.0/

When the filer creates a Snapshot, it doesn’t actually copy disk blocks;  instead, it identifies all

blocks in the file system as belonging to the snapshot as well as to the active file system.  The

technique that Snapshot uses is by duplicating disk blocks as they are modified.  This is called

copy-on-write.

8.3.1 Snapshot schedule

The current snapshot schedule is:

•  one weekly (midnight 7 days ago)

•  six nightly (midnight the current day and midnight the past 5 days ago)

•  four hourly (8am, 12 noon, 4pm and 8pm)

8.3.2 How to restore files from snapshots

Files in the .snapshot directory are read-only, hence they may only be copied (through cp).

Also due to sharing of disk space, it is wise to rename the file name to avoid overwriting the

same disk space.  The following is the procedure to restore a file named software.info in Files

directory:

charcoal{73}% pwd

/home/pleiades/staff/ecst/Files

charcoal{74}% mv software.info soft

charcoal{75}% home

charcoal{76}% cd .snapshot

charcoal{77}% ls -lu

total 88

drwxr-xr-x  24 ecst staff       4096 Mar  5 08:01 hourly.0/

drwxr-xr-x  24 ecst staff       4096 Mar  4 20:01 hourly.1/
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drwxr-xr-x  24 ecst staff       4096 Mar  4 16:01 hourly.2/

drwxr-xr-x  24 ecst staff       4096 Mar  4 12:02 hourly.3/

drwxr-xr-x  24 ecst staff       4096 Mar  5 00:01 nightly.0/

drwxr-xr-x  24 ecst staff       4096 Mar  4 00:02 nightly.1/

drwxr-xr-x  24 ecst staff       4096 Mar  2 00:00 nightly.2/

drwxr-xr-x  24 ecst staff       4096 Mar  1 00:01 nightly.3/

drwxr-xr-x  24 ecst staff       4096 Feb 28 00:00 nightly.4/

drwxr-xr-x  24 ecst staff       4096 Feb 27 00:01 nightly.5/

drwxr-xr-x  24 ecst staff       4096 Mar  3 00:00 weekly.0/

charcoal{78}% cd hourly.0

charcoal{79}% cd Files

charcoal{80}% pwd

/home/pleiades/staff/ecst/.snapshot/hourly.0/Files

charcoal{81}% cp software.info ~/Files

charcoal{82}% home

charcoal{83}% cd Files

charcoal{84}% ls -al so*

-rw-------   1 ecst staff    2412 Jan 29 11:20 soft

-rw-------   1 ecst staff    2412 Jan 29 16:19 software.info

8.4 The Source Code Manager - RCS

Keeping track of many revisions of a source file, e.g., a C/C++ source file, can be a big pain.

RCS removes much of this pain.  When  you have a new revision, you need only check it in (ci)

where you type in a message to describe it.  RCS automatically saves the user, time and date of

the check in.  To use the latest revision, you just check it  out (co).  Any one of the revisions can

be checked out and the differences between any two revisions can be displayed.  RCS saves only

the differences between files and, therefore, uses a lot less disk space then saving multiple copies

of a file.  It is recommended you check in (ci) a file often when developing a program.  For

example, check in the file at the end of each development session.  It is all too easy, especially

late at night, to accidentally delete something in your program but not know what!  In order to

recovery from this minor disaster, you would need only check out (co) the latest revision and

rebuild from there.
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This section only discusses use of RCS for a single user.  RCS has many powerful features to

manage a file which is being changed by several programmers.  Consult the appropriate UNIX

manual for these features.

8.4.1 How to Setup RCS

Create a directory called RCS (all caps) in the directory you are working.  RCS will

automatically place all its work there.  You need never bother with what is in this subdirectory.

Every time you want to use RCS in a new working directory do this step.

8.4.2 Checking In a File and Checking Out

Below is a simple file of text called resistor which will be used to demonstrate RCS.

host-name # % more resistor

Resistor, transistor, condensers in pairs,

Battery, platter, record me some airs;

Squeaker and squawker and woofer times pi,

And Baby shall have his own private Hi-Fi.

I check in the file using ci and write a description of the file.  The description can be many lines

with the last line being a period in column one.

host-name # % ci resistor

resistor,v  <-  resistor

initial revision: 1.1

enter description, terminated with ^D or '.':

NOTE: This is NOT the log message!

>> Program to demo RCS source code manager

>> .

done

I check out the file using co so I can use it.

host-name # % co resistor

resistor,v  ->  resistor

revision 1.1

done

host-name # %
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I edit the file and check it in again.

host-name # % ci resistor

resistor,v  <-  resistor

new revision: 1.2; previous revision: 1.1

enter log message:

(terminate with ^D or single '.')

>> after one editing session

>> .

done

host-name # %

8.4.3 Seeing What Revisions of a File You Have

The RCS command rlog displays information for each of the revisions saved.  Note that the

difference between revision 1.2 and  revision 1.1 is one line deleted and one line added.  Also,

one can see that there are many features to RCS which are not discussed here.  Do a man rcs

and read the manual page if you want to read about the advanced features.

host-name # % rlog resistor

RCS file:        resistor,v;   Working file:    resistor

head:            1.2

locks:

access list:

symbolic names:

comment leader:  "# "

total revisions: 2;    selected revisions: 2

description:

Program to demo RCS source code manager

--------------

revision 1.2

date: 88/05/13 11:12:41;  author: hyde;  state: Exp;  lines added/del:

1/1

after one editing session

--------------

revision 1.1

date: 88/05/13 11:02:56;  author: hyde;  state: Exp;
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Initial revision

=============================================================

host-name # %

8.4.4 Displaying the Differences Between two Revisions

The RCS command rcsdiff displays the lines of text that are different in two revisions.

host-name # % rcsdiff -r1.1 -r1.2 resistor

RCS file: resistor,v

retrieving revision 1.1

retrieving revision 1.2

diff  -r1.1 -r1.2

4c4

< And Baby shall have his own private Hi-Fi.

--

> And Baby shall have her own private Hi-Fi.

You can see I changed one word in line 4 (4c4) when I edited the file.

8.4.5 Checking Out an Earlier Revision

You can check out an earlier revision by explicitly stating the revision number as shown.  In this

case the file resistor existed and we overwrote the file.  Therefore, it is always best to check in a

file if it exist before checking it out.  That way you save the current value of the file as latest

revision.

host-name # % co -r1.1 resistor

resistor,v  ->  resistor

revision 1.1

writable resistor exists; overwrite? [ny](n): y

done

host-name # %

9. Compiling and Running Other Programming Languages

9.1 Running FORTRAN Programs

Create a file with .f as suffix, e.g.,  first.f and place in it the following FORTRAN program.

C comment lines in FORTRAN must start in column one
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C

C statements must begin in column 7 or beyond

I = 8

I = I +  1

PRINT *, 'This is a FORTRAN program. ' , I

STOP

END

To compile and link, type:

host-name # % f77 first.f -o first

To run:

host-name # % first

9.2 Running C Programs

Create a file with .c as suffix, e.g., mine.c and place in it the following C program.

/* this is a comment */

#include <stdio.h>    /* bring in I/O library */

main ( )

   {

     int i;

     i = 8;

     i = i + 1;

     printf("This is a C program. %d\n", i);

   }

There are two C compilers available.  To compile and link using GNU's C compiler, type:

host-name # % gcc mine.c -o mine

To compile and link using SPARCWorks C compiler, type:

host-name # % cc mine.c -o mine

To run:

host-name # % mine

9.3 Running C++ Programs

Create a file with .cc as suffix, e.g., mine.cc and place in it the following C++ program.
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// this is a comment

#include <stream.h>    // bring in I/O library

main ( )

   {

     int i;

     i = 8;

     i = i + 1;

     cout <<  "This is a C++ program. " << i << "\n";

   }

There are two C++ compilers available.  To compile and link using GNU's C++ compiler, type:

host-name # % g++ mine.cc -o mine

To compile and link using SPARCWorks C++ compiler, type:

host-name # % CC mine.cc -o mine

To run:
host-name # % mine
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